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1. HMI Specification

Welcome to SKTOOL online help that is meant to help you learn with the application of SKTOOL.

10.

1.

Hardware Manual

Introduce hardware structure of Samkoon HMI.

Quick Start

Introduce briefly features of the configuration software of Samkoon SK HMI, SKTOOL.
Create a New Project

Describe methods and steps for creating a project with SKTOOL.

SKTOOL Configuration Guide

Describe applications of other controls in SKTOOL.

Script instruction

Describe functions and applications of the SKTOOL script.

SKTOOL simulation

Introduce off-line simulation and online simulation functions of SKTOOL.
System settings

Describe the HMI settings of system parameters for setting HMI on SKTOOL.
Reserved Registers of SKTOOL System

Describe the registers reserved by the HMI system and their functions.
Device drivers

Introduce how to connect SK series HMI (Samkoon) and PLC.

Contact information



2. Preface

Thank you for choosing the SK series HMI products of Shenzhen Samkoon Technology Corporation Ltd. HMI is
commonly known as the touch screen.

Shenzhen Samkoon Technology Corporation Ltd., concentrated in industrial visual and touchable control
products --- research and development of human-machine interface core technology, is a national high-tech
enterprise that is professional in developing, manufacturing and distributing the most advanced industrial
products. After the accumulation of 12 years, Shenzhen Samkoon Technology, with the profound knowledge,
attracts domestic and global related industries via its strong R & D and innovation capabilities, 100%
completely independent intellectual property rights of core technology without any system basement as well

as cost-effective advantage.

Samkoon SK series human-machine interface (HMI) is mainly applied in the field of industrial control to
achieve visual and touchable control with its excellent performance in various industries, such as textile
machinery, jigger machinery, plastic and rubber machinery, injection molding machinery, packaging
machinery, ultrasonic equipment, electronic welding equipment, printing machinery, food machinery, medical
machinery, woodworking machinery, lifting equipment, intelligent buildings, water treatment equipment,
power systems, rail transit, cola system, petrochemical system, air conditioning industry, tire industry,
measurement and control equipment, teaching instrument, advanced manufacturing system and equipment
and other common equipment control industry. Having occupied the leading position in the domestic market,
it obtains a common reputation by virtue of its excellent product quality, stable software running and
powerful product features.

In view of requirements of various industrial control engineering design and construction, software
development staffs of Samkoon are committed to the development and application of universal configuration
software. In order to meet the world's vast industrial configuration needs, Samkoon launches “SKTOOL” to the
whole China and even the world, a universal version of industrial automation configuration screen editing
software.

SKTOOL is a universal industrial automation configuration software meant for the rapid construction and
production of embedded computer monitoring system. Based on the development and application
experience of configuration software, adopting the advanced computer software technology to construct the
graphical interface of the user running system by employing the window as the unit, it provides users with
solutions to practical project problems through animation display, alarm processing, process control and
report output etc., by collecting and processing filed data. It has a wide range of applications in the field of
automation.

In order to satisfy the users’ needs to use SKTOOL, we have written this manual introducing details about
system structure and features. Users can create own configuration only through simple operation so as to free
users from cumbersome programming, making it handier for more users.

This manual explains how to operate the SK series configuration software SKTOOL. Please read it carefully to
ensure correct applications.

When you cannot find a specific control in the help document, you can open the corresponding control in
SKTOOL; click the “Help” button in the lower right corner of the control to jump to the corresponding help.

Due to the limited level of the author, errors or inappropriate places are inevitable. Criticism and correction
are well welcome. If you need further information about SKTOOL configuration software and more technical
support, please contact us through the following ways. Sincerely at your service.
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Shenzhen Samkoon Technology Corporation Ltd.

Address: 3rd Floor, Block 1, Shenzhen software park, Middle Zone of High-tech,

Nanshan District, Shenzhen, China.

Tel: 0755-29419068

Fax: 0755-29455559

E-Mail: samkoon@samkoon.com.cn

Web: http://www.samkoon.com.cn


mailto:szsamkoon@163.com
http://www.samkoon.com.cn

3. Hardware Manual

This chapter summarizes the hardware part of SK series HMI, introduces the hardware dimension of products,
including the models of SK-035F, SK-035U, SK-043F, SK-043H, SK-043U,SK-050H, SK-070F, SK-070G, SK-070M,
SK-070H,SK-070F, SK-102H, SK-102C, SK-121F. Users can install them according to relevant dimensions. Refer
to specific parameters for principle and composition of HMI, technical parameters of operating environment

and correct method of wiring.

Contents:

® General

® Mounting dimensions
® HMI Structure

® Technical Parameters

® Wiring

3.1 General

general

Samkoon SK series HMI is a high-quality human-machine interface product. The entire HMI integrates the CPU
unit, input and output unit, display screen, memory and other module units. It can be widely used in control
systems in all walks of life. The optimized design of software and hardware makes the product meet the
needs of machine control in terms of touch accuracy and accuracy, as well as screen color.

SK series HMI has made great improvements on the previous basis. Compared with before, the startup speed
is faster, the page switching speed is faster, the communication speed is also faster, and the HMI sensitivity is
higher.

The following is the introduction of Samkoon SK series HMI:

1. CPU Unit

Using ARM Cortex_A8 processor, the operation speed is faster, the power consumption is smaller, and the
operation is more stable.

2. Touch panel display unit

Using a four-wire resistive touch panel, the touch precision is accurate, durable, and the touch life is long. The
display is TFT LCD with 260,000 true color display.
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3. Communication module

Adopt anti-interference, anti-high voltage, lightning strike design, enhance the accuracy and reliability of
communication, support R$232, 485, 422 communication.

4. Storage unit

The FLASH which is kept after power off is used as ROM, and the access speed is fast.
5. Power Module

Adopt high-precision switching power supply, low power consumption.

6. Chip

What is used is Tl's AM3352 chip based on ARM Cortex-A8 core. The chip has the following advantages: First,
the chip is the one with the most complete public information in the history of Tl; second, it is the one with
the clearest product positioning, an industrial control MCU; third, it is the only MCU that integrates two
MACs.

usB usB
size user Aspect com
Resolution color CAN RJ45 WIFI 4G device programming
(inch) memory ratio number
port interface
SK-035FE 3.5 320x240 |262144| 12M 4:3 1 0 0 010 0 1
SK-035UE 3.5 320x240 |262144| 12M 4:3 1 0 0 010 0 1
SK-043FE 4.3 480x272 (262144 12M 16:9 1 0 0 010 1 1
SK-043HS 4.3 480x272 (262144 12M 16:9 1 0 1 010 1 1
SK-043HE 4.3 480x272 (262144 12M 16:9 1 0 0 010 1 1
SK-043UE 4.3 480x272 (262144 12M 16:9 1 0 0 010 1 1
SK-043TE 4.3 480x272 (262144 12M 16:9 1 0 0 010 1 1
COM1:2
32
SK-043QE 4.3 480x272 (262144 12M 16:9 0 0 010 1 1
COM2:4
22/485
COM1:2
32
COM2:4
SK-043QT 4.3 480x272 (262144 12M 16:9 22/485 | 0 0 010 1 1
terminal
:COM2(
485)
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SK-050HS 5.0 800x480 (262144| 12M 16:9 1
SK-O50HE 5.0 800x480 (262144| 12M 16:9 1
SK-057FE 5.7 640x480 |262144| 12M 4:3 2
SK-070FS 7.0 800x480 (262144 12M 16:9 2
SK-070FE 7.0 800x480 (262144| 12M 16:9 2
SK-070HS 7.0 800x480 (262144| 12M 16:9 2
SK-070HE 7.0 800x480 (262144 12M 16:9 2
SK-070GS 7.0 800x480 (262144 12M 16:9 2
SK-070GE 7.0 800x480 (262144| 12M 16:9 2
SK-070GG 7.0 800x480 (262144| 12M 16:9 2
SK-070GW 7.0 800x480 (262144 12M 16:9 2
SK-070MS 7.0 800x480 (262144 12M 16:9 2
SK-070ME 7.0 800x480 (262144| 12M 16:9 2
COM1:2
32/422/
SK-070MS v3 7.0 800x480 (262144| 12M 16:9 485
com2:4
85
COM1:2
32/422/
485
SK-070ME v3 7.0 800x480 (262144 12M 16:9
COM2(o
ptional):
485
SK-070MG 7.0 800x480 (262144 12M 16:9 2
SK-070MW 7.0 800x480 (262144| 12M 16:9 2
COM1:2
32
com2:4
SK-070QT 7.0 800x480 (262144 12M 16:9 22/485
terminal
:COM3(
485)
SK-070QS 7.0 800x480 (262144 12M 16:9 [COM1:2

12




32
com2:4
22/485
terminal
:COM3(
485)

SK-102HS

10.2

1024x600

262144

12M

16:9

2

SK-102HE

10.2

1024x600

262144

12M

16:9

2

SK-102HS v3

10.2

1024x600

262144

12M

16:9

COM1:2
32/422/
485
coOM2:4
85

SK-102HE v3

10.2

1024x600

262144

12M

16:9

COM1:2
32/422/
485
comM2:4
85

SK-102CS

10.2

1024x600

262144

12M

16:9

2

SK-102CE

10.2

1024x600

262144

12M

16:9

SK-102CG

10.2

1024x600

262144

12M

16:9

SK-102CW

10.2

1024x600

262144

12M

16:9

SK-102QT

10.2

1024x600

262144

12M

16:9

COM1:2
32
coOM2:4
22/485
terminal
:COM3(
485)

SK-102QS

10.2

1024x600

262144

12M

16:9

COM1:2
32
com2:4
22/485
terminal
:COM3(
485)
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SK-104FS 10.4 | 800x600 (262144 12M 4:3 2
SK-104FE 10.4 | 800x600 (262144 12M 4:3 2
SK-121FS 12.1 | 800x600 (262144 12M 4:3 2
SK-121FE 12.1 | 800x600 (262144 12M 4:3 2
SK-121FS2.0 | 12.1 | 1024x768 (262144 12M 4:3 2
SK-121FE2.0 | 12.1 | 1024x768 |262144| 12M 4:3 2
COM1:2
32/422/
SK-156QS 15.6 | 1920x1080 (262144 12M 16:9 485
coM2:4
85

Samkoon SK series HMI has the following models:

An example of the model SK-035FE shown in the figure above:

SK: Indicates the SK series of HMI,

035: indicates the size (3.5 inches),

F: Indicates the model number, and there are H, M, G for the model number

E: Indicates that the HMI is an economical type, if it is S, it means that the HMI is a standard type, G means a
model with 4G, and W means a model with WIFI

Samkoon SK series HMI is an open man-machine interface product that provides a standard serial interface to
connect with other devices. The supported communication method is mainly serial communication, which
supports communication with mainstream PLCs on the market today, such as Samkoon FGs, Mitsubishi,
Siemens, Omron, Modicon and so on. At the same time, communication drivers can be developed according
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to customer requirements.

The configuration software of Samkoon SK series HMI is SKTOOL. SKTOOL provides users with functions such
as screen configuration, drive settings, and controls.

3.2 Mounting dimensions

The following is detailed introduction to mounting dimensions of SK HMI. Please install HMI in accordance

with fixed mounting dimensions to avoid damaging products.

The table below lists mounting dimensions of all SK series products:

SK-035

SK-043

SK-050

SK-057

Model
SK-070

SK-102

SK-104

SK-121

3.2.1 SK-035

Dimensions: 135x89x39
Installation hole size: 123x80
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0 135mm |
I |
Samkoon”
P ; 121mm |
WR I 1
2, %%I =T T-&3°
g3
(EM 3
Side
Front
[ 123mm I
o0
o
3
5
Back Mounting hole size
SK-035UE model product size (mm)
Dimensions: 96x81x47
Installation hole size: 92x77
| 96mm |
[ |
SNJul.uun" P&Id .{?NCC—DM I 90mm
oo B
; -{j El oo
5 3 0000000000
Side
Front I 92mm
@ UOONOH  HOHEEE ©
I ~
i = 3
— ’—Hm:m-‘ = N
©) ©
Biick Mounting hole size

3.2.2 SK-043

Dimensions: 150x93x39
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Installation hole size: 141x84

I 150mm |
! I 139mm
Samica L
o (&)
HE slE==—=
=3
A4 Side
Front
141 mm
° = 0000000000000
- all]| -
= 3
=3
o
Back Mounting hole size
Product size (mm) of SK-043H model:
Dimensions: 173x95x39
Installation hole size: 163x85
I 173mm I 161mm I
2 ~0
s | 99T = _=n
E 3
= 5
Side
Front
| 163mm
|
O HELEHHE LY WU R o
= (000 000000000 0
= el =5 |
= = 3
— = 5
ol o
Back Mounting hole size

Product size of SK-043U model (mm):
Dimensions: 138x86x38
Installation hole size: 132x80
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138mm

Front

0000000000000 °

Lo S—

Back

wwng

| 132mm

Mounting hole size

Product size (mm) of SK-043T model:

Dimensions: 139x86x38

Installation hole size: 132x80

139mm

Front

wwng

| 132mm

Mounting hole size

Product size (mm) of SK-043Q model:

Dimensions: 139x86x31
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Installation hole size: 132x80

| 139mm
] ; 130mm :
; (1= Ce=d] [
Front Side
: 132mm
(e ®

]
COME4ES AT

ii“!‘%ma usue

-

Back Mounting hole size
3.2.3 SK-050
Dimensions: 165x103x39
Installation hole size: 157x95
, 165mm
I
i 155mm
.| |5 $ T EEEEL e
2 3 e
LA NE.
Side
Front
0 157mm |
| 1
H
om S8AsRenGRsEs ©
= ~0
= ($)]
= ) 3
== e = &
o[ 0
Bk Mounting hole size
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3.2.4 SK-057

Dimensions: 177x140x40

Installation hole size: 163x133

3.2.5 SK-070

Dimensions: 227x153x40

Installation hole size: 210x144

| 177mm
|
Sumko
| 161mm
o g !
'; g g:[ |_|| o@..@.l:ll
RUN e T
S 3 | —=—
'."!.?M 3
Side
Front
| 163mm
I
0000000000000
0000000000000
w
W
3
e
~ Mounting hole size
| 227mm
I
Siotee! 208mm
| | = B | -
.| |8 §] Eloe-eol ]
RUN {-3*-} 5 =
& |3
Side
Front
| 210mm
=
I
=
E

Mounting hole size
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Product size (mm) of SK-070H model:
Dimensions: 205x145x38
Installation hole size: 192x138

| 205mm |
I 1
, 190mm ;
ol |[= : '
0 & ;ogi[ [0 eOe sos ]
3 5
2:1 12
I I Side
Front
: 192mm |
WIINIIIMEI IR I ©
LU LT T T
o
o0
3
5
Back Mounting hole size

Product size of SK-070G model (mm):
Dimensions: 225x153x40
Installation hole size: 210x144

I 225mm |
1 . : 208mm :
w =e o=
3 o] (o=l |
Side
Front
: 210mm |
g o« IRBIBIG0AL- , g
§ SR l:l 4~
: =
h = 5
Back Mounting hole size

Product size (mm) of SK-070M model:
Dimensions: 205x145x40

Installation hole size: 192x138
21



; 205mm

Front

L]
f0pa0BaqORNAORAORNADD |
A0RICNRRORRRONRONIN0N ~ &

i 154

Mounting hole size

Note: SK-070ME/MS v3 version COM2 only supports 485

Product size (mm) of SK-070Q model:

Dimensions: 203x145x%35
Installation hole size: 192x138

203mm

wie

Front

Side

192mm

& &
TR
@ ' 1@
Back

Mounting hole size

WWgEe |
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3.2.6 SK-102

Dimensions: 275x211x44
Installation hole size: 259x201

; 275mm .
1 1
- 257mm
oy [l o
a = _hI 1 | @@ [ |
] 3 3
| come 3 3
L Side
Front
259mm
=] L+ ]
ORAREAEOAGD  ORRGRRARRAR
H o = B [y}
H S = )
| ] -
3 E8 g5 E 3
o H | | (=] AL |
Back Mounting hole size
Product size of SK-102C model (mm):
Dimensions: 274x180x40
Installation hole size: 255x167
| 274mm |
| |
| 253mm |
| |
g 8[| H o==0000[ ]
g % Ir >
Side
Front
| 255mm |

Mounting hole size

Product dimensions of SK-102H v3 model (mm):

Dimensions: 273x211x39
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Installation hole size:

259%201
| 273mm |
T - 257mm
| 1
B%I Rl v
=
33
3 Side
Front
I 259mm |
NS
=
3
3

Back

Mounting hole size

Note: SK-102HE/HS v3 version COM2 only supports 485

Product size (mm) of SK-102Q model:
Dimensions: 273x211x44
Installation hole size: 259x201

273mm

[

wwile

Front

a Q

(LTI (I
L

2]

=]

l o

Back

Aloee 0o I§
: RE
Side
259mm
[
2
3
3

Mounting hole size B

3.2.7 SK-104

Dimensions: 312x225x55
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Installation hole size: 285x212

" 312mm :
I 1
e | N 283mm
S g‘l ERI LI ceecm0 o]
o =
e 3
Side
Front
| 285mm |
5 r 1
iy
<}
E]
=
o
Mounting hole size

3.2.8 SK-121

Dimensions: 340x256x54
Installation hole size: 330x246

| 340mm |
| |
= 328mm
LS ;I M [@--@- o]
?;N %" 3 -
Side
Front 330mm
OROBBRAERRER  BARAGRBRBRRRH
r
) 5
3
E
ol ﬁl o 1
Back Mounting hole size

3.3 HMI Structure

The entire structure of Samkoon SK series HMI consists of display area, indicator light, power interface and
communication ports. Color of all models accords to the industrial design standard, with the feature of soiling
resistance so as to work in harsh factory environment, and indicator lights on the front panel meant to check

the equipment status. Power interface and communication ports are located at the bottom of the HMI, which
meets the design criteria.
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Figure 1-11 shows the structure of HMI.

Ethernet

Power Interface | iarface USB-B USB-A

Communication
Indicator Interface
Light

Figure 1-11 Structure

Ethernet port: Connection of Ethernet cable
USB-B: Insert the U disk
USB-A: Connect with PC; download the configuration file from PC to HMI

YV V V V

Communication Interface: Communicate with PLC

3.3.1 Power Interface

The power interface of the Samkoon SK series HMI locates in the back panel. With DC24V power supply (+
15%), it shields effectively against interference, enhancing the anti-disturbance performance of the entire
system. Figure 1-12 is a view of power interface:

Figure 1-12 power interface
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3.3.2 Front panel

Figure 1-13 is a view of front panel, including display screen and indicator lights:

LCD

Indicator
Light

Figure 1-13  SK series front panel

3.3.3 Communication port

Communication ports of HMI are located in the bottom panel. Models of SK-121F, SK-102H, SK-102C,
SK-070G, SK-070M, SK-070H, SK-070F provide two standard serial communication ports while those SK-035F,

SK-035U, SK-043F, SK-043H, SK-043U, SK-050H adopting a 9-core D-type interface for connection to a PLC
or other controller and also for communication, provide one standard serial communication port.

When using a shielded cable, RS232 communication distance shall not go over 15 meters. For connection to
the computer, it has a USB communication interface used for downloading configuration (data transmission).
The transmission rate can be up to 10Mbps. Definition of communication interface differs if it is connected to
different PLC (Please inform us the type of PLC to be connected when ordering for facilitating the distribution
of communication cables).

The model in Figure 1-14 is equipped with double serial and USB-A port, the model in Figure 1-15 is equipped
with single serial and USB-A port:

27



3.3.4 Pin

COM1 COM2 USB-A

—

PLC Communication Interface

Figure 1-14  Side panels of SK (double serial)

COM1 USB-B USB-A

Figure 1-15  Side panels of SK (single serial)

Pareto diagram of 9-pin communication port, as figure 1-16:
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yol

Q9 6

o O O O

O

9—Ho o)l 5

O
Be

Figure 1-16 9-pin communication port

This port is used to connect PLC or other controllers with RS232 / RS422 / RS485 communication port

Pin RS232 RS422 RS485
1
2 RX
3 TX
4
5 GND
6 RX-
7 RX+
8 TX- B
9 TX+ A

3.3.5 Running Indicator Lights

Indicator lights of the touch screen consist of three LEDs, including Power (PWR), Run (RUN) and

communications (COM), just as shown in Figure 1-17.

Indicator
Light

Figure 1-17 SK series Running Indicator Lights
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PWR turns green when it is powered;
RUN turns yellow if CPU works normally while it lights out if CPU fails;

COM turns yellow when the touch screen is connected to PLC.

Table 1-1 shows the display states of the 3 LED indicator lights on different working state.

No power supply o o o
Power on °
CPU running ° °
Communication with
° ° Pg
connected device
O. LEDis OFF; e: LEDisON; >%:. LED is flashing

Table 1-1

3.4 Technical Parameters

This table lists major technical parameters of SK series products:

SK-035

SK-043

SK-050

Model SK-057

SK-070

SK-102

SK-104
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SK-121

»  Support up to ten formulas;

»  Support up to 512 items of data transmission;
»  Support up to 4sets of historical data collectors;
»  Support up to ten sets of digital alarm;

»  Support up to ten sets of analog alarm;

>

3.4.1 SK-035

Maximum number of screens and controls depends on the memory they occupy.

network port none
USB programming interface 1
USB device port none

COM port COM1: RS232, RS422, RS485
Display specifications 3.5" (L:W = 4:3)

Resolution 320x240

brightness 350cd/m’

color 262,144 colors

Contrast 400:1

Backlight life 50,000 hours

touchpad 4-wire high precision touchpad
RAM 128M

Power supply DC24V(+15%)

Power consumption 3W

CE certification

Complies with EN50022 and EN50024 standards

FCC Compatibility

Complies with FCC, Class A

Pressure test

1000V AC, 1 minute

Protection class

IP65 (front panel)

Working temperature

0~55C (no freezing)

Working environment humidity

5~95%RH (non-condensing)

shell plastic

Engineering plastic ABS+PC
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Dimensions 135x89%39(mm) 96x81x47(mm)
Hole Size 123x80(mm) 92x77(mm)
weight About 0.2kg
3.4.2 SK-043
network port none |none |1 none
usB
programming 1
interface
USB device port |1
COM1:232
COM1:232
COM port COM1:RS232,RS422,RS485 COM2:422/485
COM2:422/485
terminal:COM2(485)
CAN port 1 none
Display
o 4.3"(L:W = 16:9)
specifications
Resolution 480%272
brightness 400cd/m’
color 262,144 colors
Contrast 400:1
Backlight life 50,000 hours
touchpad 4-wire high precision touchpad
RAM 128M
Power supply DC24V(+15%) (DC12~24V)+15%
Power
3W

consumption

CE certification

Complies with EN50022 and EN50024 standards

FCC Compatibility

omplies with FCC, Class A

Pressure test

1000V AC,1minute

Protection class

IP65 (front panel)

Working

0~55°C (no freezing) -20~55C (nonefreezing)
temperature
Working 5~95%RH (non-condensing)
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environment

humidity

shell plastic Engineering plasticABS+PC

Dimensions 150x93%39(mm)|173x95%39(mm)|138x86x38(mm)|139x86x31(mm)
Hole Size 141x84(mm) 163x85(mm) 132x80(mm) 132x80(mm)
weight About 0.27kg

3.4.3 SK-050

network port 1 none

USB programming interface 1

USB device port 1

COM port

COM1: RS232, RS422, RS485

Display specifications

5.0" (L:W = 16:9)

Resolution 800x480

brightness 350cd/m’

color 262,144 colors

Contrast 400:1

Backlight life 50,000 hours

touchpad 4-wire high precision touchpad
RAM 128M

Power supply DC24V(+15%)

Power consumption AW

CE certification

Complies with EN50022 and EN50024 standards

FCC Compatibility

Complies with FCC, Class A

Pressure test

1000V AC, 1 minute

Protection class

IP65 (front panel)

Working temperature

0~55C (no freezing)

Working environment humidity

5~95%RH (non-condensing)

shell plastic Engineering plastic ABS+PC
Dimensions 165x103%x39(mm)

Hole Size 157x95(mm)

weight About 0.33kg
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3.4.4 SK-057

network port none
USB programming interface 1
USB device port 1

COM port COM1/COM2: RS232, RS422, RS485
Display specifications 5.7" (L:W = 4:3)

Resolution 640x480

brightness 400cd/m’

color 262,144 colors

Contrast 400:1

Backlight life 50,000 hours

touchpad 4-wire high precision touchpad
RAM 128M

Power supply DC24V(+15%)

Power consumption 6w

CE certification

Complies with EN50022 and EN50024 standards

FCC Compatibility

Complies with FCC, Class A

Pressure test

1000VAC, 1 minute

Protection class

IP65 (front panel)

Working temperature

0~55C (no freezing)

Working environment humidity

5~95%RH (non-condensing)

shell plastic Engineering plastic ABS+PC

Dimensions 177x140x40

Hole Size 163x133

weight About 0.51kg

3.4.5 SK-070

network port 1 |none 1 |none 1 |none |1
USB programming interface 1

USB device port 1

COM port COM1/COM2:RS232,RS422,R5485

CAN port none 1
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4G none 1 none
WIFI none none |1
Display specifications 7"(L:W = 16:9)
Resolution 800x480
brightness 450cd/m’*
color 262,144 colors
Contrast 400:1
Backlight life 50,000 /]NEf
touchpad 4-wire high precision touchpad
RAM 128M
Power supply DC24 V (£15%)
Power consumption 5W
CE certification Complies with EN50022 and EN50024 standards
FCC Compatibility omplies with FCC, Class A
Pressure test 1000V AC,1minute
Protection class IP65 (front panel)
Working temperature 0~55C (no freezing)
Working environment humidity|5~95%RH (non-condensing)
shell plastic Engineering plasticABS+PC
Dimensions 227x153x40 mm|203x145x40 mm|225x153x40 mm
Hole Size 210x144 mm 192x138 mm 210x144mm
weight About 0.27kg About 0.7kg
The main technical parameters
model SK-070MS|SK-070ME|SK-070MG|SK-070MW j:-O7OMS \SI:-07OME SK-070QT |SK-070QS
network port |1 none 1 none 1
USB
programming |1
interface
USB device
port :
COM port COM1/COM2:RS232,RS422,RS485 COM1;232/422/485 |COM1:232
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COM2:485(optional)

COM2:422/485
terminal:COM3(485)

CAN port none 1 none
4G none 1 none
WIFI none 1 none
Display
specifications 7w =16:9)
Resolution 800x480
brightness 450cd/m’
color 262,144colors
Contrast 400:1
Backlight life 50,000 hours
touchpad 4-wire high precision touchpad
RAM 128M
Power supply |DC24 V (+15%) (DC12~24V)+15%
Power
5W 4w

consumption

CE

certification

Complies with EN50022 and EN50024 standards

FCC
o omplies with FCC, Class A
Compatibility
Pressure test 1000V AC,1minute
Protection
IP65 (front panel)
class
Working -20 ~ 55°C ( no
0~55C (no freezing)
temperature freezing)
Working
environment |5~95%RH (non-condensing)
humidity
shell plastic  |Engineering plasticABS+PC
Dimensions 205%x145%40 mm 203x145%35 mm
Hole Size 192x138 mm
weight About 0.7kg
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3.4.6 SK-102

network port 1 |none 1|none|1 none 1

USB programming

interface '

USB device port 1
COM1:232

COM port COM1/COM2:RS232,RS422,RS485 COM2:422/485
terminal:COM3(485)

CAN port 0 1 0

4G none 1 none|none

WIFI none none|1l none

Display specifications

10.2"(L:W = 16:9)

Resolution 1024x600

brightness 500cd/m’

color 262,144colors

Contrast 450:1

Backlight life 50,000 hours

touchpad 4-wire high precision touchpad

RAM 128M

Power supply DC24V(+15%) (DC12~24V)+15%
Power consumption 7W

CE certification

Complies with EN50022 and EN50024 standards

FCC Compatibility

omplies with FCC, Class A

Pressure test

1000V AC,1minute

Protection class

IP65 (front panel)

Working temperature 0~55°C (no freezing) -20~55C (no freezing)
Working  environment

o 5~95%RH (non-condensing)
humidity
shell plastic Engineering plasticABS+PC

. . 275x211x44
Dimensions (mm) 274x180%x40(mm) |273%x211x39(mm)|273%211x44(mm)
mm

Hole Size 259x201(mm) |255x167(mm) 259x201(mm)
weight About 2.2 kg About 1.0 kg
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3.4.7 SK-104

network port 1 none
USB programming interface 1
USB device port 1

COM port

COM1/COM2: RS232, RS422, RS485

Display specifications

10.4" (L:W = 4:3)

Resolution 800x600

brightness 450cd/m’

color 262,144 colors

Contrast 450:1

Backlight life 50,000 hours

touchpad 4-wire high precision touchpad
RAM 128M

Power supply DC24V (£15%)

Power consumption 8W

CE certification

Complies with EN50022 and EN50024 standards

FCC Compatibility

Complies with FCC, Class A

Pressure test

1000VAC, 1 minute

Protection class

IP65 (front panel)

Working temperature

0~55C (no freezing)

Working environment humidity

5~95%RH (non-condensing)

shell plastic Engineering plastic ABS+PC
Dimensions 312x225%55mm

Hole Size 285%212mm

weight about 2.2 kg

3.4.8 SK-121

network port 1 none 1 none
USB programming interface 1

USB device port 1

COM port

COM1/COM2:RS232,RS422,RS485

Display specifications

12.1" (L:W = 4:3)

38




Resolution 800x600 1024x768
brightness 450cd/m’

color 262,144 colors

Contrast 450:1

Backlight life 50,000 hours

touchpad 4-wire high precision touchpad
RAM 128M

Power supply DC24V(+15%)

Power consumption 8 W.

CE certification Complies with EN50022 and EN50024 standards
FCC Compatibility Complies with FCC, Class A
Pressure test 1000V AC, 1 minute

Protection class IP65 (front panel)

Working temperature -20~65C (no freezing)

Working environment humidity|5~95%RH (non-condensing)

shell plastic Engineering plastic ABS+PC
Dimensions 340x256x54(mm)

Hole Size 330x246(mm)

weight about 1.8 kg

3.5 Wiring

Samkoon SK series touch screen requires DC 24V power supply. Figure 1-18 shows the connection of the

touch screen with PLC and PC:

39



AC220V/380V

AC DC rectifier 24V
PC

Any COM port i

D Programming Wire avr:';\):lable fgopﬁé

% gf\Ténunica\:i\?n Wire communication
ower vvire

@D 220V/380V Power Wire

Figure 1-18 Connection diagram of SK series touch screen

USB cables for connection with PC are supplied along with the machine.

40



4. Quick start of SKTOOL

This chapter introduces installation of SKTOOL configuration software, as well as basic functions and main
characteristics of the software. It also introduces in detail the composition of the software system and the
functions of each component, helping users to understand the overall structure framework of SKTOOL
configuration software. In addition, it introduces the hardware and software requirements of SKTOOL, and
the installation process and working environment of SKTOOL, helping users to learn use of this software and
create application projects.

Contents:

® What's SKTOOL

® System demand

® Set up SKTOOL Software

® Run SKTOOL

® Edit Interface and System Composition

® Basic Operations

4.1 What's SKTOOL

What's SKTOOL?

o B

Created for the HMI of Samkoon SK series from Shenzhen Samkoon Technology Co., SKTOOL configuration
software is a development system with an integrated development environment and abundant, advanced
functions. Taking advantage of the Windows system, it shows its simplicity and good interface consistency.
The menu Layout close to that of Windows operating, it is facile to learn and apply, thus engineers can easily
develop their proper projects for the configuration used in the SKTOOL. It features a decrease of time to
develop automation projects and to upgrade, maintain the system, as well as a seamless integration with
third-party applications and productivity enhanced.

Functions and features of SKTOOL are summarized below:
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1. Screen

Samkoon SK HMI is equipped with 2,6 million display colors, much more bright compared with products of
other manufacturers. Using SKTOOL, engineers can find it more convenient and efficient to design
configuration projects benefitting from bright colors and rich gallery. When downloaded to HMI, the
configuration displays exactly what PC screen shows without image distortion. Meanwhile the operation
interface of SKTOOL is clear and concise, consistent with the design of layout menu of Windows. Taking
advantages of major display configuration software and HMI configuration software, it is available to

configure a high-performance and high-quality engineering document.

2. Complete functions

SKTOOL provides complete functions, including basic drawing shapes, color rendering, text rendering, library
system, animation, bitmaps status, trend display, alarm control, etc.. SKTOOL is even equipped with new
multiple sets of formulas and historical data, controls effects of pressing and so on. All what is needed for
engineers to achieve an expected success is designing programs and configurations according to their own

demand project features.

3. Communication

SKTOOL supports PLC communication drivers of major manufacturers in the world, such as Samkoon, Siemens,
Mitsubishi, Omron, Fujitsu, Panasonic, Schneider, Emerson, etc., covering the very most of them. At the same
time we can customize certain PLC communication drivers. SK-121F, SK-102H, SK-070F, SK-070H from SK

series can simultaneously load two communication drivers.

4. Resource

SKTOOL provides abundant resources where Gallery contains three-dimensional indicator lights,
three-dimensional buttons, motors, three-dimensional tank, three-dimensional pipes, electronic, bar graphs,
etc., and lots of them come with graphic animation, so you can create a vive animation. It supports a custom
gallery and pictures inserted from Windows. SKTOOL also provides rich functions of controls, such as trends

and alarm controls, etc., to meet the needs of various configurations.
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4.2 System demand

SKTOOL System demand

Content:

® Hardware demand

® Software demand

4.2.1 Software demand

SKTOOL configuration software can run on the following operating systems:
- Microsoft Windows NT Server 4.0 or later;
- Microsoft Windows NT Workstation 4.0 or later;

- Microsoft Windows 98, Me, 2000, XP, win7 or later.

-/

L Tips:
SKTOOL will refuse to install if it does not match the above versions of operating systems.
Recommended systems:

Windows XP SP3 version; windows7 32; windows7

There is no difference between Chinese and English operating system.

4.2.2 Hardware demand

Minimum hardware requirements for SKTOOL are:

CPU: Minimum Pentium 3-800MHz;
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Memory: The memory should be 128 MB or above if it is Windows 9X operating system;
System memory 256 MB or above if Windows NT operating system;
System memory 256 MB or above if Windows 2000 or XP operating system;
Graphics: Windows-compatible system, containing more than 1MB of video memory, compatible with 1024 *
768 resolution, 256-color mode;
Hard: A minimum of 200MB of hard-disk space occupied by SKTOOL configuration software.
Computer with a USB interface;

Mouse with two buttons and keyboard.

t_}..
“A Tips:
SKTOOL can possibly fail to install or run if the configuration of computer is inferior to the above.
Recommended configuration:
CPU: Equivalent to Intel's Pentium 800 or above;
Memory: The memory should be 256MB or above if it is Windows 9X operating system;
System memory 512MB or above if Windows NT operating system;
System memory 512MB or above if Windows 2000 or XP operating system.
Graphics card: Windows-compatible system, containing more than 1MB of video memory, compatible with
1024 * 768 resolution and 65535 color mode.

Hard disk: 200MB or more hard disk space.

4.3 Set up Software

Set up SKTOOL Software

'

SKTOOL is an application software designed for Microsoft Windows 32-bit system. Before installing the
software, please make sure that the computer software and hardware meet the minimum requirements for
installation.

Execute the installation disk distributed with the product to install SKTOOL. Specific steps are as follows:
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Start Windows;
Insert the disc in the appropriate drive;

Contents of the disc are as shown in Figure 2-1, please verify them:

3

= l -':-' | ___'J;'—
- ‘ ——
autorun Readme setup_SK SKTOOL Help

Figure 2-1 Disk content

Please contact us if anything is missing. Thank you for your support and we will serve you sincerely.

After inserting the disk it will automatically pop up SKTOOL setup window (if there is no pop-up window,
directly open the disc, execute the file setup_SK.exe.

After launching the installation, a language selection box pops up as follows. According to user’s needs to
select English or Simplified Chinese to install the configuration software. Now choose to install this "English"
as an example. Select "English", click "OK", and after a few seconds the splash screen will pop up.

In the dialog box, select “Next” to continue the installation or choose “Cancel” to exit the installation program,

as shown in Figure 2-3.

i8) Setup - SKTOOL7.0 l=|E] %

Welcome to the SETOOLY. 0 Setup
~ Wizard

This will install SETOOLY. O T.0.0.0 on wour
computer.

It 15 recommended that you close all other
applications before continming.

Click Fext to continue, or Cancel to exit Setup.

Lﬂext > 1 l Cancel

Figure 2-3 Installation Welcome Interface

In the License Agreement dialog box, please choose whether to accept the terms of the software, and then
click Next, as shown in Figure 2-4:
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{8l Setup - SKTOOL7.0 =] =

License Agreement
Fleaze read the following important information before 4
continuing.

Pleaze read the following License Agreement. Tou must accept the
terms of thiz agreement before contimming with the installation.

Readme |:|

Yerzionm: T.0

Realse date: 201512

@ I accept the agreement
(711 do mot

amkoon Techn

cept the agreement

l 4 Back ][ Hext 2 _] I Cancel ]

Figure 2-4 License Agreement dialog box

In the Destination Folders dialog box, select the installation folder. The default folder is "C: \ Program File \
SKTOOL6.2\", click Change can select the installation path, then click Next

8 Setup - SKTOOL7.0 == ®

Select Destination Location
fhere should SETOOLT.O0 be installed?

j Setup will install SETOOLT. O into the following folder.

To continue, click Hext., If wou would like to select a different
folder, cliclk Browse.

C:h"Program FileshSETOOLT. O Browse. ..

At least 0.7 ME of free dicsk space 1z required.

< Back ][ Hext * _] I Cancel ]
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8 Setup - SKTOOL7.0 == ®

Select Components
¥hich components should be installed?

Select the components wou want to install; clear the components sou
do not want to install. Click Hext when you are ready to continue.

\EEEE =
SETOOL 271.6 MB
mRTE 256. 5 ME
- V] g AR O IR 0.7 MB
wo (] B 181. 4 MB
w (V] HEEATEE 13.9 ME

Current selection requires at least 545 2 ME of disk space.

Samkoon Technology Corporation Lid

< Back ]Lﬂext > 1 I Cancel ]

Figure 2-5 Installation Path Interface

Click Next in Figure 2-5, a selection interface shows where to store the file, the default file or others; click
Next, as shown in Figure 2-6:

8 Setup - SKTOOL7.0 == %

Select Start Menu Folder
Where should Setup place the program’ = shorteutsT

Setup will create the program’ s shortents in the following
j Start Memm folder.

To continue, click Hext., If wou would like to select a different
folder, cliclk Browse.

SETOOLT. O Browse. ..

Samkoon Technology Corporation Lid

I < Back ]Lﬂext> 1 I Cancel ]

Figure 2-6 Installation File Interface

Whether to Create Desktop Shortcut Interface, click Next, as shown in Figure 2-7:
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i3 Setup - SKTOOL7.0

Select Additional Tacks
¥hich additional tasks should be performed?

Select the additional tasks wou would like Setup to perform while
installing SETOOLT. O, then click Hext.

#dditional icons:
E Create a desktop icon

< Back J[ Hext = ] I Cancel J

Figure 2-7 Whether to Create Desktop Shortcut Interface

Installation confirmation interface shows three elements: the installation path, files for the installation and

whether to create a shortcut.

i3 Setup - SKTOOL7.0

Ready to Install
Setup is now ready to begin installing SKTOOLT. O on wour
computer.

Click Install to contimue with the installation, or click Back i1f you
want to rewiew or change any settings.

Destination location: -

C:%"Program Files\3ETOOLT. O '—‘

Setup g%ﬁﬁ%

Selected components: ‘

m

SKIQOL
mAET B i
AERCIAEED
iz I
Fi ¥
% Back J[ Install _] I Cancel J
Figure 2-8 Installation Affirmation Interface

Installation Interface, Click Cancel to cancel the installation. As shown in Figure 2-9:
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i3 Setup - SKTOOL7.0 L= 2|

In=talling
Pleaze walt while Setup installs SETOOLT. 0 on wour computer.

Extracting files. ..
C:hProgram Files\SETOOLT. 0ASETOOLT. O, exe

Samkoon Technologzy Corporation Lid

Figure 2-9 Installation Interface

Having installed the software, it will install USB driver automatically. As shown in Figure 2-10:

i3 Setup - SKTOOL7.0 L= 2|

In=talling
Pleaze walt while Setup installs SETOOLT. 0 on wour computer.

Installing Serial Port drivers ...

Samkoon Technologzy Corporation Lid

Cancel

Having installed the driver, it will display Installation Completed Interface; click Finish to end the installation

guide. As shown in Figure 2-11:

49



i3 Setup - SKTOOL7.0 L=

Completing the SETOOLY. 0 Setup
Wizard

Setup has finished installing SETOOLT. O on pour
computer. The application may be launched by
selecting the installed 1cons.

Click Finish to exit Setup.

Figure 2-11  Installation Completed Interface

After the installation, the SKTOOL6.2 icon will appear on the desktop. As shown in Figure 2-12:

Figure 2-12  desktop shortcut

If installation CD is unavailable, please download the corresponding download package on Samkoon official

website.

4.4 Uninstall Software

Uninstall SKTOOL Software /

To uninstall SKTOOL configuration software, please follow these steps:
The first method:

Step one: Select the Windows "Start" - "Programs" - "SKTOOL", choose Uninstall SKTOOL option.
As Figure 2-13 shows:
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Open

Run as administrator

Troubleshoot compatibility
Dpen file location
= | Pin to Taskbar

© Default Prog| Pin to Start Menu
| W Desktop Gad
€ Internet Explﬂi
| £ Windows An oo e 9
| 553 Windows Fay

Restore previous versions

& Windows M ! Cut
£ Windows Up| Copy
- KPS Viewer Paste

| Accessories

. Games Delete
| Maintenance % Rename
SKTOOLT.O | _
{ Properties

B SKTOO, e
i Uninstall SKTOOL
Startuo

Control Panel

Figure 2-13 choose Uninstall SKTOOL option

Step Two: In the pop-up dialog box, left click "Yes" and wait for Windows system to automatically delete
SKTOOL software. When the removal is completed, left click "Finish" button, as shown in Figure 2 -14 and
Figure 2-15:

I N

SKTOOL?.0 Uninstall

' of its components?

Figure 2-14 Confirm Uninstalling
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SKTOOL Uninstall

Uninstall Status

Please wait while SETOOL is remowved from your computer.

Uninstalling SKTOOL. . .

Cancel

Ld B
SKTOOL Uninstall [

:I SKTOO0L was successfully removed from your computer.

Figure 2-15 Uninstall Completed
The second method:

Step One: Select in the Windows "Start" - "Settings" - "Control Panel", go to the Control Panel interface and
then select the "Add / Remove Programs" dialog box, as shown in Figure 2-16

e |
@Qv‘ﬁ » Control Panel » Programs » Programs and Features - | 3 | | Search Programs an: P I
Control Panel H =
o i Uninstall or change a program
View installed updates To uninstall 2 program, select it from the list and then click Uninstall, Change, or Repair.
) Tum Windows features on or
=it Organize »  Uninstall oy @
Name ° Publisher Installed On  Size
(7] Microsoft Visual C++ 2008 Redistributable - %86 9.0.3..  Microsoft Corporation 6/11/2018 596 KB 9
HSamkoon Drivers Samkeon Corporation 9/3/2018 236KB 1

[EJskT00L7.0 7.0.00 ShenZhen Samkoon Technolog...  9/3/2018

EVhuwere]  Uninstall | VMware, Inc. 6/11/2018 395MB 9

< i ] v

. “j|  ShenZhen Samkoon Technology Corpora..  Help link: http://www.samkoon.com.cn/

Suppart link: http://www.samkoon.cam.cn/

Figure 2-16 Add / Remove Programs
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Step Two: Select SKTOOL in the left area of the Figure 2-16, click "Change / Remove" button and follow the
second and third step of the first method. Then the system will automatically delete SKTOOL configuration
software and its corresponding components.

4.5 Run SKTOOL

RUN SKTOOL |

A shortcut will appear on the desktop after the installation of SKTOOL, as shown in Figure 2-17:

o

CKTOOLT.0

Figure 2-17  desktop shortcut

At the same time, program packages are added to the start menu of Windows, as shown in Figure 2-18

Open
Run as administrator
Troubleshoot compatibility
Open file location

. | Pin to Taskbar

'ﬁ Default Prog, Pin to Start Menu

| @ Desktop Gad
& Internet Exph

|
| £ Windows Anl Send to E

| 55 Windows Fay

Restore previous versions

2] Windows M ! Cut
£ Windows Up| Copy
i KPS Viewer Pacte

, Accessories

. Games Delete
, Maintenance 'EE' Fename
SKTOOLT.0 | _
{ Properties

B SKT00L. e
5 Uninstall SKTOOL
Startup

Control Panel

Figure 2-18  start menu program icon

53



Double click the shortcut on the desktop or the Start menu, click Run SKTOOL.exe SKTOOL configuration

software program group, and the interface is shown as Figure 2-19:

SKTOOL7.0 = B8] %

@7 N DEH &) 0w ™ @aﬁ“ i Lﬁ>f:_§¢i » |s-n;en1,_1| =] [hinese =]
mMmilEsSz4MELEE SHRE 0L B8 885

Window 5 x +| Mool B _ o
Function elements | Base elements |
Standard List | =
4 Operation setings - Function graphics —
= Textlibrary G

& Address library 7 @ —

“ 1 ‘\i:reen Bit switch Word Screen

5] 000:Screenl switch Button

B Window

m

I |

Function BitLamp MultiState

Historical data collector
¢ Alarm Login

@] Recipe

Button Lamp
7 Data Transfer _EC) 1
4/ Script [ L L]
£ Script Editor MultiState  Numentric  Numerical
& Global Script Switch Displav Input
L Init Scriot i - ASTH
; — ; el Y wm
| T | S :
x
(=
*x=b33.y= Coordinates: Left Top: Size: Width Height: SKTOOL SK-070FS(300x480)

Figure 2-19  Software running interface

4.6 Edit Interface and System Composition
Edit Interface and System Composition

Simple and user-friendly, editing interface of SKTOOL is easy to operate. This chapter introduces
configuration screens and each function button of this software.

Contents:

® Editing interface of SKTOOL

® System composition of SKTOOL

4.6.1 Edit Interface

SKTOOL Edit Interface |

54



Created for the HMI of Samkoon SK series from Shenzhen Samkoon Technology Corporation Ltd. SKTOOL
configuration software is a development system with an integrated development environment and abundant,
advanced functions. Taking advantage of the Windows system, it shows its simplicity and good interface
consistency. The menu Layout close to that of Windows operating, it is facile to learn and apply, thus
engineers can easily develop their proper projects for the configuration used in the SKTOOL. Development

interface and functional areas are as shown in Figure 2-27:

SKTOOL?.0 mebar L )
] I S Y Drawi SEE ~— " Standand teelbar . PEDit] | Language Selechon I
@ L H P |_ x : & ;Qy ] ? 2 J 7 \':\\ » |Screenl | | x| |[Chineze ~|
i = = .| @uicksbutton) g Dieelia e
Ml =S4 F RSO BRE < ) D EE 885

Window ex¢ - | jlcol Box & X
- Function elements IM|
Standard List 'l =
4 Operation settings - Function graphics i—
= Textlbrary
& Address library - i@] |y
+ Wacen Bit switch Word Screen
0002 crecnd, switch Button
B Window 1 €
Historical data collector ‘ | E m !!!:l
Emglmﬁeﬁl_mgpma_mag,aﬁ | IE@QQ)J Q,_,_l.lmgj FunctionTi@@lbexe  MultiState
£ Recipe ‘ g Button Lamp

7 Data Transfer

4/ Script Tl m ﬁ

# Script Editor MultiState  MNumentric  Numerical
G Global Scrpt Switch Display Input
i |nit Scriot = ‘ - . = m|| §|I S
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Figure 2-27 Interface and areas of the software

® Title Bar: Display the name of SKTOOL version.
® Menu Bar: Show various command menus of SKTOOL that are all drop-down menu.

® Standard Toolbar: Shortcuts to commands button; Display file; open project; new project; restoration
and other function buttons.

® Toolbox: Basic configuration controls designed for engineers to configure; contain function controls and
basic controls.

® Picture area window: Window for engineering staff to configure, edit graphic object.

® Project Manager: Communication connections, parameter settings, picture management, alarm settings,
set formula and tree-form menu set by historical data collector.

® Information output window: Prompts concerning information input, output, error messages and other
tips as engineers conduct configuration editing and compiling.
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® Standard Status Bar: The current state of configuration, including the mouse coordinate, the control
type, the control coordinate, the control size, etc..

4.6.1.1 menu bar

SKTOOL menu bar

'

Editing menu bar of SKTOOL configuration software provides users with an extensive menu options, almost
covering all the engineering tools and editing commands needed. The menu bar includes File menu, Edit
menu, View menu, Draw menu, Object, Screen menu, Setting menu, Download menu, Help menu, Language
selection menu, and also a Right-click menu.

File(F) Edi{(E) View Draw(H) Object Screen(P) Setting(3) DownlLoad(D) Option Help(H) Language Selection
Figure 2-28 Menu bar
File menu
"File" menu supports operations of New project (N), Open Project (O), Close, Save (S), Save As and Quit (Q). If
a certain item shows gray, it indicates that the operation is invalid in the current environment. The method of

opening the file menu is to click "File (F)" on the top left corner of the software, then ejects a pull-down File
menu toolbar.

& Mew Pro(N)... Crl+N

& OpenPro(0)... Cirl+0
Close

M Save(s) Ctr+S
Save As
Quit{Q)

Figure 2-29 “File” menu
® New Project: shortcut key Ctrl + N; to create a blank project.
® Open Project: shortcut key Ctrl + O; to open a project file created, saved before and suffixed by .skm.
® Close: to close the current project file without exiting SKTOOL configuration software.

® Save: shortcut key Ctrl + S; to save the current configuration file having been modified, the name and
save path of the file are by default as before.

® Save As: to save the current configuration file; available to override the name and save path of the
project.

®  Exit: to exit SKTOOL configuration software.

Edit menu
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"Edit" menu consists of a set of commands used to edit texts, graphics and other content in the screen. There
are Undo, Restore, Cut (T), Copy (C), Multiple copy (D), Paste (P), Delete (D), Select All (A), Align, Layer, Group,
Mirror, Zoom, Grid, Property setting, Find Address, Address Table, Reverse Select, Macro search, Macro
Manager. If a command in the menu bar is gray, it mean in current operation, that command is invalid. To
executive these commands, you should first select the graphic object to be edited, and then choose the
corresponding command in "Edit" menu. But there are in "Edit" menu some commands that are group
commands. If so, a little triangle will show on the right of the command and each command, with a
drop-down menu, has a corresponding shortcut.

® Undo: shortcut key Ctrl + Z; to cancel the last operation command and your recent action.
® Restore: shortcut key Ctrl + Y, to restore the last operation command and your recent action.

® Cut: shortcut key Ctrl + X, to delete your selected graphical objects and copy them into the clipboard
buffer.

® Copy: shortcut key Ctrl + C; to copy the selected graphic object into the paste buffer.

® Multiple copy: to copy a quantity of selected graphical objects in horizontal and vertical directions, and
then the address can be in ascending order of 0-255 units.

® Paste: shortcut key Ctrl + V, to copy and paste buffer graphics objects into the current screen.

® Delete: Del, to remove selected graphical object from the screen.

Undo Ctri+Z
Redo Ctrl+Y
Cut Ctrl+X
Copy Ctr+C

I Paste Ctrl+V
Multiple copies

¥ Find/Replace  Ctr+H

7< Delete Del
Selectall Ctri+=A
Align 4
Layer L
Assemble r
Mirror 14
Zoom »

[ Grid

Property setting

# Find Address  Ctril+F
& Address Table

Reverse Select

Rotate

& ¢

Script search

[Z ScriptManager

Figure 2-30 “Edit” menu
® Select: shortcut key Ctrl + A; to select all objects in the current frame of the project.

® Align: to make selected objects (more than two) aligned according to the selected type alignment,
including Top, Bottom, Vertical Center, Left, Right, Horizontal Equal Interval, Vertical Equal Interval,
Make same width, Make same height, Make same width and height.
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Layer: to place the selected objects to a different picture level. You can choose Bring To Top, Bring
Forward, Send to Bottom or Send Backward.

Group: to combine selected objects (more than two) into one control, or split This command can be
selected more than one object (two or more) are combined into a control, an object can also can split a
detachable object or split combined objects into the original object. When using Group, please be sure
not to assembly objects to touch, otherwise objects can’t be touchable after being downloaded to the
touch screen. Layer is recommended if it is necessary to overlay touchable objects.

t_}..

< .

L Tips:
When using Assemble key, do not assemble objects to be touched, or it can’t be touched after downloading
to the touch screen. Users may use Layer command to superpose touch objects.

® Mirror: to rotate the selected object in accordance with certain rules, horizontally or vertically.

® Zoom: to zoom the current screen in accordance with a certain proportion scale for a more fine control
operation; zoom options are Zoom In, Zoom Fit and Zoom Out.

®  Grid: to place or cancel a grid with certain width in the current screen.

® Property settings: to open the Properties window of an object (when one single object is selected) and
that of a screen (when nothing is currently selected).

® Find Address: to find the address you are using.

® Address Table: to open or close the list of addresses being used. Address Table is a list of address used
by objects, easy to find and replace.

® Invert Selection: to select all objects not being chosen in the current screen and objects that are chosen
before are not included.

® Macro Search: to locate calls of the macro in the project; you can optionally specify to search or
manually enter the search.

® Macro Manager: Execute this command to see locations of all macros used; you can choose to display
macros of all the screens or those of a specific screen.

View menu

This menu allows developers to custom their operating interface according to their own habits: decide

whether certain operating window is shown in the current operating environment. The icon V on the left of

the command means the display of the toolbox on the screen, otherwise it is hidden.
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Scale toolbar

Status toolbar
Find/Replace toolbar
Compile/Download toolbar

_:lv Tool box
|'v standard status bar

|l» Information Output Window
| : Layouttoolbar
v Project Manager
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Group toolbar

Lock/Unclock toolbar

Display controls address

i

Resetlayout

3 N T R )

AMI parameters settings

Draw menu

The menu is mainly used to draw graphics on the screen. SKTOOL provides straight line (L), Polyline (B), Curve
/ Arc (A), Free Lines, Rectangles (R), Round Rectangle, Ellipse (E), Polygon (Y), Arc, Text (T), Open Library (0),
Build Library (C), Table, Scale. It's convenient for engineers to change the color, text, size and location of
picture elements created by the Tools menu.

+ Line(L)

“ PolyLine(B)
“~ Curve/Arc(A)
“w. Free curve
i Rectangle(R)
i25 Round Rect
.+ Ellipse(E)
£+ Polygon(Y)
I~ Sector

[Tl Text(T)

<% Regular polygon
.+ Open Library(0)

& Table
B Scale

Figure 2-31 “Draw” menu
® Line: Execute this command to draw a straight line in any direction within the current screen.
® Polyline: Execute this command to draw a polyline in any direction within a current picture.

® Curve / Arc: Execute this command to draw a line in the current screen, after finishing drawing by right
button, the radian of drawings can be adjusted as needed.

® Free line: Execute this command to draw a line in the current screen in any direction, lines are drawn
with the movement of the mouse.
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Rectangle: Execute this command to draw a rectangle of any size in the current screen.

Rounded Rectangle: Execute this command to draw any rectangle with rounded corners in the current
screen.

Ellipse: Execute this command to draw any size of ellipse in the current screen.

Polygon: Execute this command to draw an arbitrary polygon in the current screen.

Arc: Execute this command to draw any sector in the current screen.

Text: Execute this command to create a transparent rectangle where you can enter any text inside.
Open Library: Execute this command to open the picture library of the system.

Build Library: Execute this command to convert the image control drawn by user into a file of library; it is
easy to operate next time.

Table: Execute this command to create a table with required ranks in the current screen.

Scale: Execute this command to draw a desired scale.

Object menu

"Object" menu consists of a set of touch keys and function keys, including Bit Switch, Word Switch, Screen
Button, Function Button, Multifunction key, Stepping Button, Single Button, Combo Box, Sliders, Numerical
Display, Numerical Input Display, ASCIl Display, ASCIl Entry, Bit Lamp, Multistate Switch, Multistate Lamp,
Message display, Time Display, Date Display, Weekday Display, Static Picture, Picture Display, GIF Display,
Dynamic Diagram, Dynamic circle, Dynamic Rectangle, Flowing block, Graphics Move, Animation, Bar Graph,
Meter, Arc chart, Trend Chart, XY Trend Chart, Historic trend, Data group, Historical data, Alarm Control,
Alarm Bar, Historical Alarm, Timer, Message Board, Recipe selector, Recipe data display, Keyboard and Qrcode.
'Object' menu corresponds to the third row of the toolbar.

Bit Switch: Execute this command to create touch keys for performing bit manipulations to the
connected device, including Set ON, Set OFF, Dot and Invert.

Word switch: Execute this command to set a touch key for performing word bit operation in the current
screen to the connected device, including Add, Subtract, Increasing, Decreasing, Set Constant, Enter

Value, Enter Password.

More Button: Execute this command to reach the Screen Button, Function Button, Multifunction key,
Stepping Button, Single button, Combo Box and Sliders.

Numerical Display: This command is used to draw on the current screen a numerical display frame
reflecting numerical value of certain monitored address.

Numeric Input Display: Execute this command to draw on the current screen a numerical display frame
for data input and digital value display of certain monitored address.

ASCII Display: Execute this command to draw on the current screen a numerical display frame for ASCII
code.

ASCII Input Display: This command is used to draw on the current screen a frame of display and output
for the input of ASCII code.
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Bit Lamp: Execute this command to create on the current screen a picture monitoring the bit status of
one single connected device.

Multistate Switch: Execute this command to create multi-state button monitoring numerical value
changes of single address of the connected device according to the change of status.

Multistate Lamp: You can place a picture in the current screen monitoring the word status of multiple
consecutive device addresses.

& Bitswitch
\®) Word switch
More Button »

=) Numentric Display
% | Numerical Input
w= ASCI Display

% ASCI Entry

. BitLamp

Hi MultiState Switch
B MultiState Lamp

7. Message Display

Time/Date 3
[ Static Picture
.| Picture Display
@F GIF Display

Dynamic Diagram  *
mm Bar Graph
# Meter
T Arc chart

Chart 4
« Historical data

Alarm s
=) Timer
“» Message Board
Recipe selector
[ Recipe data display
Bl Keyboard

2 arcode

Figure 2-32 “Object” menu

Message Display: Execute this command to create a display control showing pre-configured message on
the current screen.

Time Display: Execute this command to insert the time control on the screen to show the time.

Date Display: Execute this command to insert the date control on the screen to display the date.

Week Display: Execute this command to insert a week control on the current screen to display the week.
Static Picture: Execute this command to insert a static image of the local hard disk on the current screen.

Picture Display: This command is used to draw a picture display frame on the current screen for
displaying a plurality of pictures.
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GIF Display: Execute this command to draw a picture display frame on the current screen to display a
static or animated image suffixed by .GIF.

Dynamic Diagram: Execute this command to open the windows of Dynamic Circle, Dynamic Rectangle,
Flowing block, Graphics Move and Animation.

Bar Graph: Execute this command to insert a columnar control on the current screen to observe the
changes in the numerical value of monitored address according to the rise and fall or the right-left
traverse of the columnar picture.

Meter: Execute this command to create an instrument on the current screen to monitor the changes of
numerical value of single address of connected device.

Arc chart: Execute this command to insert a sector control on the current screen for reflecting the
numerical value of monitored address and the reflection area can be presented by Pie FG Color, Pie BG

Color or Bottom Color.

Chart: Execute this command to open the window of Trend Chart, XY Trend Chart, historical trend and
Data group.

Historical Data: Execute this command to create a display control on the current screen to show
messages saved by the historical data collector.

Alarm: Execute this command to open windows of Alarm Control, Alarm Bar and History Alarm.

Timer: Execute this command to insert a control on the current screen to trigger a particular function
according to time conditions.

Message Board: Execute this command to insert on the current screen a control where users can write.

Recipe Selector: Execute this command to insert on the current screen a recipe control that shows all
names of recipes if they exist.

Recipe Data Display: Execute this command to insert a recipe data display control on the current screen,
which shows all the data of recipes if they are set up.

Keyboard: Execute this command to insert a keyboard control on the current screen, which can be any
key in the keyboard when custom the keyboard.

Qrcode: Execute this command to insert a Qrcode control on the screen for user-defined Qrcode; It
should be used in concert with an input control, otherwise the address is invalid and the Qrcode won’t
appear.

Screen menu

"Screen (P)" menu consists of commands applied to screens, including New Screen, Screen Properties (P) and
Delete Screen (D)

4 New Screen
Screen Properties(P)

Delete Screen(D)

Figure 2-33 “Screen” menu
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® New Screen: Execute this command to create a new screen in the current project.

® Screen Properties: Execute this command to open the properties of the current screen by which you can
set the name and background.

® Delete Screen: Execute this command to delete the current screen.

s
SA Tips:

Please make sure the current screen is the one you want to delete and whether there are needed controls
before operating cause it cannot be undone.

Setting Menu

"Setting (s)" menu contains the following commands: Preference Settings (P), File Protection (M), Macro
Editor, Global Macro, Initialization Macro and Add Customize Keyboard.

Preference Setting(P)
File Protection{M)

4 Macro Editor

@ Global Macro

¥ InitMacro

Add Customize Keyboard

Figure 2-34 “Setting” menu
® Preference Setting: Execute this command to open the preference setting window, in which you can
modify the HMI model, display mode, splash screen, screen saver time, flicker frequency, alarm sound,

touch sound, password and settings of initial lever.

® File Protection: Execute this command to open the password setting window of file protection through
which you can set a password to protect the file of the current project is set in the password window.

® Macro Editor: Execute this command to open the macro editor where you can add, modify, compile or
delete a macro.

® Global Macro: Execute this command to open a global macro setting screen, set or modify the global
macros.

® |Initialization Macro: Execute this command to open the interface of initialization macros setting to set or
modify initialization macros.

® Add Customize keyboard: Execute this command to open a user-defined keyboard.
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S Tips:
Please keep in mind the password since password is necessary to open the project configuration file after the
setting. And it is case-sensitive.

Download menu

Applied to compile and download the configuration project, “Download” menu contains eight commands,
which are Compile (C), Off-line Simulation (M), Online simulation, USB download (D), Upload, Pack/Unpack,
Extract project & save as and Extract Remote Simulation Engineering (A). Having connected PC to a touch
screen through USB cable, the configuration project can be downloaded via USB download to the touch
screen, but you have to compile it before downloading.

o Compile(C)

B offine-Simulation(hd)
® QOnline simulation

« Download(D)

? Upload
Pack/Unpack

Pick project save as...

Pick up the Remote Simulation Engineering{A)

Figure 2-35 “Download” menu

® Compile: Execute this command to examine configuration projects created by users and prepare for
download operations.

® Off-line Simulation: Execution of this command can invoke the application program of SKTOOL picture
configuration and open the simulation interface. Users can simulate the configuration project running
currently on PC to observe the effect, in order to modify the screen. Please save it Off-line simulation
before you save the user first.

® Online Simulation: This command can be called SKTOOL screen configuration software application, open
the simulation panel, users can simulate engineering currently run on a PC to observe the effect, in
order to correct the picture. When online simulation, you can also use the PC's Ethernet or serial
communication device connected to data communications and communications test status. Please save
it before the online simulation.

® USB Download: Execution of this command can download engineering configuration compiled by
SKTOOL software to HMI through a USB cable equipped with the touch screen. Before downloading,
please compile and save the project.

® Upload: Execute this command to upload the historical data, configuration, recipes, and historical alarm

from the HMI to a PC through a USB cable equipped with the product.
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Pack/ Unpack: Execute this command to compress the project configuration into an XXX.skr file, or to
extract the compressed file to the project configuration file .skm.

Extract Project & Save As: Execute this command to compile the current configuration project to a
binary file named u-disk-prj.bin. Saving it in the U disk, instead of USB cable downloading, can update it
automatically to the HMI.

Extract Remote Simulation Engineering

Option menu

# Find Address Ctrl+F
1 Address Table

% Scriptsearch

7| ScrptManager

1l Textbatch modification

Figure 2-36 “Option” menu

Find Address: Execute this command to find the address you want and show the using status of the
address on Information Output Window.

Address Table:Execute this command to look for all contols’ status on all windows or assigned
window.

Script Table:Execute this command to check the using of the assigh macro instruction,and show it on
information ouput window.

Script Manager:Execute this command to look for all macro instructions’ status on  all windows or
assigned window.

Text batch modification:Execute this command to bitch modify assigned text.

Help menu

"Help" menu can call up the Help documentation and About SKTOOL: its version number and copyright
notice.

Help(H) F1
About SKTOOL-VE.0.0.24

Figure 2-37 “Help” menu
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The help file is shown in Figure 2-37:

(@ SKTOOL Help W — E=REERTS

E I A R -
== Fm ERQ)

BRO |#70 | wExo | 5

@ Fraface ®
X fi amkoon
@ Quick stert of SKIOOL

@ Basic steps of creating a

@ SETOO0L Configuration Guide ‘, E' =
@ Macra » ,

@ Simulation ‘I k

@ System Settings

@ Reserved Registers of SETO "
@ comection mene mairle ||| Human Machine Interface
@ Device driwer

@Number zignals of communic
@ Appendizx

@ Operation case (Supplement : .
[E)Faq & Selutions Welcome to SKTOOL onhne help that 15 meant to help

@ Contact

m

you learn with the application of SKTOOL.

« | [T | v 1. Hardware Manual

— = -

Figure 2-38 Help file

Version number and copyright statement of SKTOOL are shown in Figure 2-38:

About SKTOOL-V7.0.0.15 @ % |

SETOOL-YT. 0. 0. 15 [ ok J
Shenzhen Samkoon Technology Corporaticon Ltd.

Warning: Unauthorized Eeproduction, Copying Fart or
811 of the Contentz of thiz Software Would Constitute
a Tort!

Figure 2-39 Version number statement

Language Selection menu
The menu can realize Chinese-English switch.

Select "Chinese", and the software is the version of simplified Chinese; or "English", then the English version.

Chinese
Ev English

Right click menu

Right click menu is set to facilitate user’s operations, which is consistent with most Windows user's operating
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habits and styles. Lots of configuration functions can be found here: Attribute, Objects, Library, Cut, Copy,
Multiple copy, Paste, Delete, Select all, Align, Layer, Group, Zoom, Grid, Screen.

Attribute
Object i
Library b
Cut Ctri+X
Copy Ctrl+C
Multiple copies

| Paste Ctrl+V

< Delete Del
Select all Ctri+A
Align P
Layer »
Assemble 4
Zoom r

Ll Gnd

Figure 2-40 “Right click” menu

@ Attribute: Execute this command to open the properties window of a control (one single object selected)
and the screen (no object selected).

® Object: Execute this command to open all of the object controls in the Object menu.
® Library: Execute this command to open the gallery or generate pictures.

®  Cut: Shortcut Ctrl + X; this command can delete your selected graphical objects, and copy them into the
clipboard buffer.

® Copy: Shortcut Ctrl + C; execute this command to copy the graphic object of your choice into the paste
buffer.

® Multiple copy: Execute this command to copy a quantity of selected graphical objects in horizontal and
vertical directions, and then the address can be in ascending order of 0-255 units.

® Paste: shortcut key Ctrl + V, to copy and paste buffer graphics objects into the current screen.
® Delete: Del, execute this command to remove selected graphical object from the screen.

® Select: shortcut key Ctrl + A; execute this command to select all objects in the current frame of the
project.

® Align: Execute this command to make selected objects (more than two) aligned according to the

selected type alignment, including Top, Bottom, Vertical Center, Left, Right, Horizontal Equal Interval,
Vertical Equal Interval, Make same width, Make same height, Make same width and height.
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® Layer: Execute this command to place the selected objects to a different picture level. You can choose
Bring To Top, Bring Forward, Send to Bottom or Send Backward.

® Group: to combine selected objects (more than two) into one control, or split This command can be
selected more than one object (two or more) are combined into a control, an object can also can split a
detachable object or split combined objects into the original object.

|
< .
L Tips:
When using Group, please be sure not to assembly objects to touch, otherwise objects can’t be touchable
after being downloaded to the touch screen. Layer is recommended if it is necessary to overlay touchable
objects.

® Zoom: Execute this command to zoom the current screen in accordance with a certain proportion scale
for a more fine control operation; zoom options are Zoom In, Zoom Fit and Zoom Out.

®  Grid: Execute this command to create or cancel a grid with certain width on the current screen.
® Screen: Used to create a new screen, open screen property window and delete a screen.
]

Please make sure the current screen is the one you want to delete and whether there are needed controls
before operating cause it cannot be undone.

4.6.1.2 Standard Toolbar

SKTOOL Standard Toolbar

i

SKTOOL offers a series of shortcut tool buttons, some of which are tool command buttons while some belong
to editing commands. You can easily get to the needed commands here instead of seeking it in the menu bar
if familiar with these buttons. Each button has tooltips that will appear when the mouse is placed on the
button. SKTOOL provides a total of 35 tool buttons, which will turn gray if the If the operation is invalid in the
current environment.

EBRGHELOC XM |24t 88 I RATEEG |QQDDO | Feem = EEEm- s =
MiesS2dHELNER wERe) <) ss|as

Figure 2-40 Standard Toolbar

Each command in the toolbar correspond to that in the menu, and their functions are respectively:
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New Project: shortcut key Ctrl + N; to create a blank project.

i' Open Project: shortcut key Ctrl + O; execute this command to open a project file created, saved before

and suffixed by .skm.

New Screen: Execute this command to create a new screen in the current project.

Save: shortcut key Ctrl + S, used to save the current screen configuration that has been changed, with

the file name and directory being the same as the original.

)

Undo: shortcut key Ctrl + Z; to cancel the last operation command and your recent action.

e

Redo: shortcut key Ctrl +Y, to restore the last operation command and your recent action.

i

/W Cut: shortcut key Ctrl + X, to delete your selected graphical objects and copy them into the clipboard
buffer.

Copy: shortcut key Ctrl + C; to copy the selected graphic object into the paste buffer.

Paste: shortcut key Ctrl + V, to copy and paste buffer graphics objects into the current screen.

~<

Delete: Del, to remove selected graphical object from the screen.

Group: Execute this command to combine several graphic objects you select into one object.

Ungroup: This command can decompose a combination of graphic objects you have selected into the

original graphic objects; it’s the inverse operation of Group.

Flip Horizontal: Execute this command to make a single graphic or multiple graphics pivot horizontally.

Flip Vertical: Execute this command to make a single graphic or multiple graphics pivot vertically.

Grid: Execute this command to create or cancel a grid with certain width on the current screen.

69



g—"l
A
Zoom in: Execute this command to magnify the current screen two times; to continue to enlarge,

please continue to execute the command.

“. Zoom fit: Execute this command to restore the current screen to the standard size.

(=)
~ ™ Zoom out: Execute this command to shrink the current screen half the size; to continue zooming out,
proceed to execute the command.

Englizh vl

Language: Execute this command to select the language you want.

gtatel =
Status drop-down box: If select a control with status, the drop-down box will show the
number of control status; if the number in the box changes, the status of the selected control will switch into
corresponding status.

S jv Screen frames: Execute this command to jump to the page you want to view.

—F Property settings: Execute this command to get the properties of the selected key.

(=
Locked: Execute the command to lock the key selected on the screen and it can not be moved after
locking.

Unlock: Execute this command to remove the locking of screen buttons.

Find/replace the button:click the button, and the user can find all the usage of the specific register and
can be replaced by the other.

EE} Address Find: Execute this command to find out whether an address is occupied and the search results
are displayed in the "information output window".

o]
Address display: Execute this command to browse the used address of all controls in certain screens

or all the screens.

" Find macro: Execute this command to find whether a macro is used; the search result is displayed in
the "information output window".

Macro Manager: Execute this command to see the macro condition of all controls in certain screens or
all the screens.
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~ IClick the button to modify the selected control, screen, and text in the window.

<l

Rotate the command, select the control, and use it to rotate freely in the center of the control.

z

Use this command to open the tool buttons that are not displayed; when the mouse moves away, the
popup disappear.

il

Off-line simulation: Execute this command to run directly off-line simulation command.
. . . . . . . . .

Online simulation: Execute this command to run directly online simulation command.
Ta
4

Compile: Execute this command to check user’s own configuration engineering and get ready to
download.

2 Download: Execute this command to pop up the download dialog; after connecting the SK HMI to PC,
you can download the configuration project to the touch screen.
-~

Upload: Execute this command to upload historical data, configuration, formulas and alarm history
from a running HMI to a PC via the equipped USB cable.

LR O

Layer: Level drop-down box, includes four operating controls: Bring to top, Send to bottom, Bring forward and
Send backward

»  Bring To Top (F): Execute this command to shift the graphic object you selected to the top of the screen.

» Send To Bottom: Execute this command to shift the graphic object you selected to the bottom of the
screen.

»  Bring Forward: Execute this command to shift the graphic object you selected forward one layer.

»  Send Backward (B): Execute this command to shift the graphic object you selected backward one layer.

L @

Size: Size drop-down box includes three operating controls: same width and height, same height, same width.

» Make same width: Use this command to make a group of selected patterning the same width as that
marked by a black point.

»  Make same height: Use this command to make a group of selected patterning the same height as that

marked by a black point.
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»  Make same width and height: Use this command to make a group of selected patterning the same width
and height as that marked by a black point.

MiES£4H4HE

Alignment: Alignment drop-down box includes a total of eight operating controls: left-aligned, right-aligned,
Vertical Center, Horizontal Center, Top, Bottom, Horizontal Equal Interval and Vertical Equal Interval.

»  Left: Shortcut key Ctrl + Left, execute this command to left justify the left edges of selected graphic
objects.

»  Right: Shortcut key Ctrl + Right, execute this command to right justify the right edges of selected graphic
objects.

»  Top: Shortcut key Ctrl + Up, execute this command to align upper boundaries of selected multiple
graphic objects top.

»  Bottom: Shortcut key Ctrl + Down, execute this command to align lower boundaries of selected graphic

objects bottom.

Horizontal Center: Execute this command to align selected graphics horizontal center.

Vertical Center: Execute this command to align selected graphics vertical center.

Horizontal Equal Interval: Execute this command to make two or more controls align horizontally equal

interval.

» Vertical equal interval: Execute this command to make two or more controls align vertically equal
interval.

Y V VY

4.6.1.3 Project Manager

SKTOOL Project Manager

SKTOOL Project Manager window is in the left of configuration software window, below the toolbar. You can
here set the parameters of the touch screen, including Multi-language Settings, Connection, Setting, Screen,
Window, Historical data collector, Alarm landing, Formula, Data transmission and Macro; Connection consists
of Connection 1 and Connection 2 settings which contains HMI parameter settings, HMI state, PLC control,

Clock, File encryption, HMI protection and Variable table.
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Figure2-41 Project Manager window

4.6.1.4 Toolbox

®

SE il SKTOOL Toolbox

SKTOOL Toolbox provides a wealth of tool buttons, some of which are functional control buttons, and some
are basic controls. After being familiar with these buttons, designers can quickly find the commands they

need instead of searching in the menu bar. SKTOOL supports totally 47 function controls and 14 basic
controls.
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Figure 2-42  Toolbox functional control buttons
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Figure 2-43 Toolbox basic control buttons

Toolbox individual operating controls and menu content corresponding to each other, each button functions

are:

E/j Line: Execute this command to draw a straight line in any direction within the current screen.

5 Polyline: Execute this command to draw a polyline in any direction within a current picture.
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’LE Curve / Arc: Execute this command to draw a line in the current screen, after finishing drawing by

right

button, the radian of drawings can be adjusted as needed.

bi?ﬂ Free line: Execute this command to draw a line in the current screen in any direction, lines are drawn

with

the movement of the mouse.

@ Circle/Ellipse: Execute this command to draw any size of circle or ellipse in the current screen.

E:E Rectangle: Execute this command to draw a rectangle of any size in the current screen.

m Rounded Rectangle: Execute this command to draw any rectangle with rounded corners in the current

screen.

Q Polygon: Execute this command to draw an arbitrary polygon in the current screen.

D Arc: Execute this command to draw any sector in the current screen.

. |
" Text: Execute this command to create a text input on the screen.

0=

‘| Table: Execute this command to create a table with required ranks in the current screen.

Scale: Execute this command to draw a desired scale.

w Open Library: Execute this command to open the picture library of the system.

o
11

conn

Bit Switch: Execute this command to create touch keys for performing bit manipulations to the
ected device, including Set ON, Set OFF, Dot and Invert.

Word switch: Execute this command to set a touch key for performing word bit operation in the current

screen to the connected device, including Add, Subtract, Increasing, Decreasing, Set Constant, Enter Value,
Enter Password.

R

Screen Button: Execute this command to set the switching of screens, including opening screen, open

the previous screen, close and Open screen, Closes screen, Open previous screen and Close open screen.

-
i_h.l Function Button: Execute this command to set a certain function control of the operating system,
including Turn off background light, Confirm alarms, Restart HMI, Set screen saver time, Write recipe to PLC,
Read recipe from PLC, Set the date and time, Clear alarm, Switch to previous recipe, Switch to later recipe,
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Save current recipe, Screenshots, System parameters, User login, Cancel the user login, Touch sound ON / OFF,
Alarm sound ON / OFF, Clear all historical data, Clear alarm history, Unlock HMI protection, read& save recipe,
Spare function, Overload recipe, Switch language, Print screen to printer, Slave devices IP config, DIP switches
1 and 3 feature set.

A
v

Stepping button: Execute this command to create a stepping button control in the current screen to

realize the cyclic switching of execution states.

[
Single button: Execute this command to create a single button control in the current screen; click the
designated state area, then the state will switch accordingly.

I}

Combo box: Execute this command to create a drop-down box button control in the current screen,
for viewing and selection. Once user selects an item, the corresponding value will be written into the control
address of character buffer.

f=

Slider: Execute this command to create a slider analog switch control in the current screen; drag the
slider to change the value of corresponding character register addresses.

123
i_ Numerical Display: This command is used to draw on the current screen a numerical display frame
reflecting numerical value of certain monitored address.

........

123
ii Numeric Input Display: Execute this command to draw on the current screen a numerical display frame

for data input and digital value display of certain monitored address.

ASCHl
ﬂ ASCII Display: Execute this command to draw on the current screen a numerical display frame for ASCII
code.

8|

ASCII Input Display: This command is used to draw on the current screen a frame of display and output
for the input of ASCII code.

—
u Bit Lamp: Execute this command to create on the current screen a picture monitoring the bit status of
one single connected device.

Multistate Switch: Execute this command to create multi-state button monitoring numerical value
changes of single address of the connected device according to the change of status.

BEE \ultistate Lamp: Place a picture in the current screen to monitor the word status of multiple
consecutive device addresses.

4

Message Display: Execute this command to display corresponding message information according to
different monitoring address.
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B¢

E E Recipe Selector: Execute this command to insert on the current screen a recipe control that shows all
names of recipes and enter, monitor contents of RWIO.

a4l
Recipe Data Display: Execute this command to insert a recipe data display control on the current screen,
which shows all the data of recipes if they are set up.

@ =
Multi-function button: Execute this command to create a multi-function button in the current screen to
realize multiple functions through one key.

Keyboard: Execute this command to insert a keyboard control on the current screen, which can be any
key in the keyboard when custom the keyboard.

Time Display: Execute this command to insert the time control on the screen to show the time.

m—
[Humr]
f Date Display: Execute this command to insert the date control on the screen to display the date.
[pem—

EMEH: Week Display: Execute this command to insert a week control on the current screen to display the

week.

m Static Picture: Execute this command to insert a static image of the local hard disk on the current
screen.

Picture Display: This command is used to draw a picture display frame on the current screen for
displaying a plurality of pictures.

@ GIF Display: Execute this command to draw a picture display frame on the current screen to display a

static or animated image suffixed by .GIF.

Q:Q’ Dynamic circle: Execute this command to create a dynamic circle in the current screen whose size and
location transform according to the continuous address change of connection device.

&
Dynamic Rectangle: Execute this command to create a dynamic rectangle in the current screen whose
size and location transform according to the continuous address change of connection device.

| =]
b
F Flow block, use this command to create a simulation control of flow state in the current screen.

i Graph Move: Execute this command to create a graph display frame in the current screen whose
graphic state and location change according to the continuous address change of connection device.

Animation: Execute this command to create an animation control in the current screen to move the
control.
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@ b’\ Meter: Execute this command to create an instrument on the current screen to monitor the changes of
numerical value of single address of connected device.

E Arc chart: Execute this command to insert a sector control on the current screen for reflecting the
numerical value of monitored address.

‘ Pie chart: Execute this command to insert a sector control on the current screen for reflecting the
numerical value of monitored address

- Bar Graph: Execute this command to insert a columnar control on the current screen to observe the
changes in the numerical value of monitored address according to the rise and fall or the right-left traverse of
the columnar picture.

@ Trend Chart: Execute this command to create a trend chart control in the current screen to monitor
the change trend of continuous address value of connection device.

4

XY Trend chart: Execute this command to create a XY trend chart control in the current screen to
monitor the change of two continuous address value of connection device.

=

Data group display: Execute this command to create a date group display control in the current screen

to display several groups of data in the trend chart.

)

%

=i Historical Trend Chart: Execute this command to create a historical trend chart control in the current
screen to display historical data in the trend chart.

“ Historical record display: Execute this command to create a historical record display control in the

| —

current screen to display historical data collected.

Historical Alarm display: Execute this command to create a display control of historical alarm record in
the current screen to show historical alarm data.

H Alarm display: Execute this command to create an alert box control in the current screen to display the
date, time and message of each alert.

m Alarm Bar: Execute this command to create an alert bar in the current screen to scroll display alert
information.

i
LI Operation log: Execute this command to create an operation log display frame in the current screen to
display the time, user and contents of the operation.
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(@)
% Timer: Execute this command to create a macro timer in the current screen to control the execution of
the macro.

=,
-/ Message Board: Execute this command to create a message board control in the current screen where
users can write.

EE=E QRcode: Execute this command to create a QR code control in the current screen to display character
or number with the help of input control.

Eﬂ:ﬂ Corner flow block: Execute this command to create a Corner flow block control in the current screen to
display the shape and flow speed.

Multi-Window: Execute this command to create a multi-window control in current screen to display the
assigned window.

[}

ScrollBar
:Scroll bar control to draw different types of scroll bars for table data browsing

U

Pipeline
:Pipeline control, and the control of a scroll bar

4.6.2 System Composition

SKTOOL is a configuration editing software of Samkoon HMI. SKTOOL allows engineers to edit the
configuration on the PC, and then download the final configuration and required communication driver to
communication and the required driver to the storage mechanism of the touch screen with a USB cable; HMIs
can be controlled and monitored after being connected to PLCs or other connection devices through
actuators and serial communication ports. Figure 2-44 shows SKTOOL system composition.

SKTOOL Touch Screen PLC

Graphic Editing

| =]
Fa In
¢ | &
—5 & 2
H g
8 =3 N =
GIF Display N2 =} 1=
|3 = z
|8 = E
~N 2 =2 =
¢ N8 = 2
N = L
|8
e

Communication
Display

J

Figure 2-44 SKTOOL System Composition
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4.7 Basic Operations

This chapter describes briefly the mouse usage, shortcut keys and some of the terminology of SKTOOL
software.

Contents:

® Mouse usage and shortcut keys
® SKTOOL's common terms

4.7.1 Mouse usage and shortcut keys

When use the mouse to create configuration screens on the configuration screen editor, the mouse is as
shown in Figure 2-45:

. right button

left button d
7
/

Figure 2-45 Sketch of mouse

The following is several common operations of mouse and their purposes:
O Left-click

Press the button on the left side, then release—this is referred to in the book [click], used in the selection
menu, to select the object, choose Tool buttons, edit configuration picture, confirm settings.

© Double left click
Press the button twice in rapid succession on the left side—this is referred to [Double] in this book, applied to
attribute setup for existing parts on the screen: screen and window attributes, touch screen connection

properties, set properties; to change settings of Historical data collector, formulas, alarms and other control
options.

© Right-click
Press the key on the right, then release —this is referred to in the book [right-click]. Right-click on a part can

open the right drop-down menu, or right-click in the space display the context menu. You can also quit the
editing state, restore the mouse state.
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O Drag

Move the mouse while hold the button-- this is called in the book [drag], using the drag operation can select
multiple items to move parts, mobile pop-up edit windows.

Shapes of the mouse

While edit with SKTOOL configuration software, the shape of the mouse will changes with different
operations to distinguish different types of operation.

The following table 2-1 shows available operations under various shapes of the mouse when edit screens:

% Select objects; click tool buttons
+ Paste
+\\ Draw graphs
1 Input text
1 Enlarge the objet vertically
+—* Enlarge the objet horizontally
& Enlarge the objet vertically and horizontally
A& Readjust
‘s Enlarge the objet vertically and horizontally
q& Rotate the object
Table 2-1 Shapes of the mouse and their meanings

Shortcut keys

Table 2-2 below lists common shortcut keys. Designers can use these keys to quicken the configuration.

CTRL+C Copy
CTRL+V Paste
CTRL+X Cut
CTRL+F Jump picture
CTRL + drag Copy the selected objet and move it
CTRL + left click Select multiple objects
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Move the selected objet left and right, up and
> Y
down
ESC Undo the operation
DEL Delete
Table 2-2 Shortcut keys

4.7.2 Common terms

Table 2-3 below displays some common terms in configuration editing.

Project

Shortened from user’s application system.
Introducing the concept of project means to
make complex computer expertise easier for
the general engineers. Files created in SKTOOL
configuration is suffixed by .skm; it can be
stored in any specified location.

Object

Operating goals and operating environment,
collectively called Object, such as windows,
components, data, graphs and objects

Select the object

Making a window or object operable by a
mouse click is referred to select object, the
selected object (including windows) is also
known as the current object

Configuration

Define, create and edit object in a window
environment and set its status feature
(attribute) parameter

Attribute

Name, genre, sate, property and the usage are
called collectively Attribute

Menu

A set of execution commands. For example,
the system menu "File" menu is used to
dealing with execution commands related to|
project documents. SKTOOL menus are all
pull-down menus that can also be divided intoj
multiple levels, each known as a
sub-sub-menu

Command Button

Buttons with certain command operations,
part of which in the toolbar while part of in
the menu bar

Set ON

Switch the object with bit status display to
sate "ON"

Set OFF

Switch the object with bit status display to
sate "OFF"

Style

A transition effect of object from the

foreground to the background color
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Memory variables related to the current
Address .
object
. . Communication devices connected to current
Connecting device .
project
Control Set of particular functions
Table 2-3 common terms
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5. Basic steps of creating a new project

This chapter introduces basic steps of creating a new project.

Contents:

® C(Create new project

® Set parameters and add graphic object
® Download configuration engineering
® Upload configuration engineering

® Upload historical data record

® Pack/Unpack

5.1 Create new project

SKTOOL Create new project

This operation is necessary when engineers need to create a new project. Select New Project in the File menu

or New Project button @in the tool bar, then SKTOOL will pop up the "New Project dialog box" where you
can decide the name and storage path of the project. Select the corresponding HMI model; click OK to
complete creating a new project and enter into the dialog box of Communication port settings; click Cancel to

exit the dialog box.

1. New project dialog box
Project name:
Path: Storage path of new project file; the default is C: \
Model: Available models for projects:
SK-035FE(320*%240)
SK-035UE(320*240)
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SK-043FE(480%272 )
SK-043FS(480%272 )
SK-043HE(480%272 )
SK-043HS(480%272 )
SK-043UE(480%272 )
SK-050FS(480%272 )
SK-050FE(480*272 )
SK-050HS(800*480 )
SK-050HE(800*480 )
SK-057FE(640*480 )
SK-070FS(800*480 )
SK-070FE(800*480 )
SK-070HS(800*480 )
SK-070HE(800*480 )
SK-070GS(800*480 )
SK-070GE(800*480 )
SK-070GG(800*480 )
SK-070GW/(800*480 )
SK-070MS(800*480 )
SK-070ME(800*480 )
SK-070MG(800*480 )
SK-070MW(800*480 )
SK-102FS(800*480 )
SK-102FE(800*480 )
SK-102HS(1024*600)
SK-102HE(1024*600 )
SK-102CS(1024*600 )
SK-102CE(1024*600 )
SK-102CG(1024*600 )
SK-102CW/(1024*600 )
SK-121FS(800*600 )
SK-121FE(800*600 )
SK-104FS(800*600 )
SK-104FE(800*600 )

The default model is SK-070FS(800*480), the screen resolution (800 * 480) in the bracket is not displayed in

the dialog box.
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Display mode: Display direction of the touch screen used by the project. Available models include:
Horizontal: Configuration with the touch screen being horizontal.
Vertical: Configuration with the touch screen being vertical.

The default mode is Horizontal.

Mew Praoject

Project Properties

Project Name:

Path:|D: “Program Files\SETOOLT. 0\Project® Browse. .

Model: SK-0T0FS

Show Model:[Horizontal

Model Parameters
Remote: HO
Size: T inch
Resolution: 8002480 Pizels (VGA)
Color: 262,144 Color= TFT LCD
FAM: 120
Power supply: DC24Vi(+/-15%)
COM1: R5232/R3422/R3485
COMZ: R3232/R3422/R3480
TSE: 2 Ports B-type/4-Type
Ethernet: RT45

[ Next || Cancel

Figure 3-1 New project dialog box

The figure above is the New Project dialog box where engineers decide the Name, Path, Model and Display

Mode, then click Next to set communication port.

Specific model is determined by the HMI model that user has.

]
L Tips:
The name of the new project cannot contain the following characters: \ /: * "<> | ?.

The location of the new project cannot contain the following characters: \ /: * "<> | ?.

Communication Settings dialog box

Communication settings dialog box is used to set communication parameters of the communication port of
HMI. Only correct communication parameters can ensure normal communication between PLC and touch

screens. The specific communication parameters depend on the model of PLC to be connected.
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Connection Name: The name of the communication port.
Device Service: Selection of PLC brand and CPU type.
Connection Interface: Select COM port or Ethernet port.

PLC Continuous Address Interval: Set PLC consecutive address space; the default value is recommended.

@ MNew Link

Link ID:!

Link Name: Link 1

Jink Interface:[Coml

Device Service:[Samkoon '] [FGS Series

L Continuous Addresz Space:| 32 -

Next | Cancel |

Figure 3-2 Communication setting dialog box

The figure above is the dialog box of communication port settings where engineers choose corresponding
device services according to types of connection devices. To use Ethernet connection, choose “Direct

Connection(Ethernet)” option in the “Connection Type”.

]
L Tips:
SK-070F, SK-070H, SK-102H, SK-121F, they all have two communication ports; it’s decided by the used port

when connected to one PLC. SK-035F, SK-043F, SK-043H, SK-050H only have one COM port; just set COM1

port.
Connection ID: Internal parameters cannot be changed!

When you configure the communication properties can also be set in the Project Manager connection, the

other parameters are set in the communication properties.
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3. Screen Properties settings box

Click “Next” in the Communication settings dialog box to pop up a New Screen dialog box where you can set
the name and the background color of screens. The default name is a screen number; the default background
color is blue. When we create a new picture every time, SKTOOL configuration software will assign a screen
number to the new screen to indicate the screen order of the current project. Numbers start from 1, that is,
the serial number of the first frame 1. No. 5 is the fifth screen. To change the background color of the new
screen, just click the rectangle behind the Background Color to bring up the color selection frame. With more
than two hundred kinds of colors for users to select quickly, SKTOOL software provides the most extensive
selection of color. If you are dissatisfied still, you can click on the lower right of the color selection box to
customize color. In the Custom Colors dialog box, select the basic color first, then color in the middle of the
square area; drag the mouse to adjust the desired color area; you can also type in the right vertical rectangle

and drag the mouse to complete the desired color, at last click OK. You can also enter directly basic color

values.
7| =
@ New Screen
Screen Name: Screenl
Background
@ Default
B¢ Color:
Pattern: “:‘ Solid 2
) Pictur
| Finish || Cancel |
Figure 3-3 New screen dialog box
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Select Color

Bazic colors

HE N
HE N
H NN
H NN
H NN
NN
|
T e Hue: 0 -+ Red: 255_3_-
EERREREEE Sat: 0 |2 Green: 255 %]
D l:l D l:l D |:| D l:l Fal: 255-: Blue: 255 [&]
’ 4dd to Custom Colors ] Alpha charmel: 255 -:-
[ ok || cancel

Figure 3-4 Color selection dialog box
Engineers can also choose own pictures as the screen background. Click the path icon to find the image path.
@ FPicture i u
Figure 3-5 Set the path of picture

Click OK to complete the above steps, the system will immediately open the screen you just created.

Preparations for new construction are done. Then it’s time to edit own configuration project.

5.2 Set parameters and add graphic object

Set parameters and add graphic uhject/

Parameter settings:

1. You can modify the parameter settings through Preference Setting in the drop-down menu Settings, or
double-click the HMI Parameter Settings in Setting, Project Manager. Then a pop-up dialog box is shown as
Figure 3-6 below:
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HMI Parameter Setting ? =
eters | -~ assword ! =r and downloading I e locations and alarm system | Other I WVHNC
Model Other
mI Model:|SK*DTUFS 'J Floating-point settings
_ ; @ Standard
Display mude:|HUrlzuntal v‘ @® Appoint
T Start Setrting #Thiz =et of some agreement effectiwve
Splazh screan:[Screenl v] 7| Display controls press !
reen Saver Time: 1 S min HMI Language: |Chinese v|
icker Freguency: 10 =0 1s el At ouah
Touch zound:| 4 woice tips - [l Uze custom labeling
7] Screen saver scree
[ Load LOGO screen
7] External boot image
Alarm zetting
Alarm sound: No sound reminders hd
Operation Node . .
| Screen flick when alarm occurs
quch method: @ Touch Type Op () USE Mouse .
[¥] Hide the mouse e
[T] Turn on backlight when alarm occurs
ok ] | cancel ‘ | help

Figure 3-6 General parameter setting dialog box

»  HMI Model: Change the HMI model through this option.
»  Display mode: Adjust horizontal or vertical display screen.
»  HMI Start Setting
® Splash screen: The start screen of HMI when powered on
® Screen Saver Time: Set screensaver time
® Flicker Frequency: Set the flicker frequency of objects or controls which can blink; you can change the
speed of flicker by inputting directly a value and clicking the spin button.
® Alarm sound: When the alarm occurs, the touch screen can remind users through sound; the right
drop-down menu contains two cases, with or without sound reminder.
® Touch sound: Options in the right drop-down menu can decide Sound reminder or No sound reminder.
® Screensavers screen: Select a screen among the existing screens as screensaver screen; just touch the
screen to return the former screen.
® |f Load Screen: If choose this option, the HMI will display the selected loading screen after power-on for
a certain while, and then switch to the splash screen; thus users can give some tips or notes.

»  Other settings
® Hide mouse cursor: Whether to display the mouse
® Floating-point settings:
[Standard]: High byte floating point ahead while the low one behind;
[Appoint]: users determine the order.
® Invalid touch: Select the "Use custom labeling", which means touchable controls cannot be touched,
then the picture marking the control chosen by user is untouchable.
® Display controls pressing effect: SKTOOL is newly added pressing effect display. When the pressing
effect is applied, rectangular pressing trace will appear if users touch the control. The pressing trace
color depends on user’s preference. Currently Bit switch, Word switch, Screen button, Function
button, Numeric input and ASCII input controls support this effect. The default is No effect.

s
“A Tips:

Pressing effect of elliptical controls is still a rectangle.
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_-_". Display controls pressing effect

Figure 3-7
2. Set user password

HMI Parameter Setting P =

I eters | vvassword | v oand dewnloading | cve locations and alarm system | Other | VHC
Tzer 1
M U=e
Tzer 2
[ U=e
Tser 3
T Uze
Tzer 4
| Use
User &
| Use
Uszer 6
] Use
Tzer T
[ U=e
Tzer &
[ U=e

11t user lewel: NULL o [¥] 411ows uploading configuration
7] Supreme authority password [7] Enter the pazsword when 1
[7] Password when updating configuration through
[ ok ] | cancel | | help ]

Figure 3-8 Set user password in HMI parameter setting dialog box
This function has 8 sets of user password, each of which has eight levels of password for users to choose.

® The default user level: The current default user class is NULL.

® Allow uploading configuration: If select this option, you can upload the project from HMI to PC;
otherwise it cannot be uploaded.

® Enter the password when uploading: Whether uploading projects requires a password.

® Password when updating configuration through U disk: The password set up, the password is necessary
when you update the HMI configuration projects through U disk.

® Supreme authority password: This password can operate all controls limited by grades.

Upload: Whether this password enables upload configuration projects from HMI to PC.

® Permissions: Whether this password can perform all limiting operations.

3.Settings of connection to the printer and downloading

Click "Settings of connection between HMI and printer" button, as shown in Figure 3-9:
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HMI Parameter Setting ? P9

| rreters ! "'asswora_.l =t and downloading | e locations and alarm system | Other | VHC

7] Open printing function

Dowmload =et Image Doymloading Options
owmload mode:| USE v| () Eeep the original fuo
IF Address: .0 .0 .0 Port: 12345 @ Corwerted to JPG fon
[¥] Clear historical alarm records Hote: To ensure the
configuration running
[#]Clear Local area datz [¥] Download recipe speed Degree, it is
recommended to convert
V] Clear historical data records the imagze to JPG format
[ ol ] ‘ cancel | | help I

Figure3-9 Settings of connection between HMI and printer

This page contains parameter settings of connection between the printer and the HMI; users can select
corresponding parameters according to printer models.

Download settings:

® Download mode: Users need to select USB or Ethernet connection to download. If choose the Ethernet,

it’s necessary to set the IP address and port number (IP address and port number are those of the
HMI).

® Clear historical alarm records: Whether to clear the history alarm information before downloading.
® Clear historical data records: Whether to clear the history data information before downloading.
® Download Formula: Whether to download formulas in the current project to the HMI.

Image Downloading Options:

® Keep the original format: Selecting this option means retain the image format unchanged when
downloading.

® Convert to JPG format: Convert all images to JPG format before downloading them into HMI.
(Note: Due to the larger space occupied by BMP format images, it’s suggested to select this option.)

4.Storage location and alarm system, as shown below
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HMI Parameter Setting

| ~reters | -assword | -vr and dowmloading | e locations and alarm system | Other | THG |

Storage Location

orical data storage:Local (FLASH) -
ztory alarm storage:Local (FLASH) -

Syaten Alarm

[7] Use the system alarm

[ [2):4 ] | cancel | | help ]

Figure 3-10 Saving position and system alarming setting dialog

»  Storage location: Location for historical data, historical alarm and screen shots. Provide "Local (FLASH)",
"U disk" three options for users to choose according to their need. The default is Local (FLASH).

»  HMI IP: Set touch screen network parameters

»  Alarm system

Use the alarm system: Whether to use the system alarm. When an alarm occurs, the alarm system displays

the current alarm information at the top or bottom of each screen according to the options set by users.

Alarm background color, Text color, Font and Font size, these are attributes options of the alarm display
system. Users can set these options as needed.

Way of display: "Always display" refers to the alarm displayed all the time; "Cyclic display" means that alarm
display or disappear within a certain period to achieve the flicker effect.

Position of alarm bar: Choose the position where the alarm bar appears.

5.0ther setting,as show below
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HMI Parameter Setting L2 | ® |

| reters I “agsword I ¢ and downloading e locations and alarm system | Other WHC

7] Screensawver unlock need password

Pazzword:

7] Start system time paszsword protection

Pazaword: |

[ ok } [ cancel ] | help

Figure 3-11 Screensaver unlock need password

»  If checking out this section,user need to input this password when unlocking the screensaver.
»  Start system time password protection: When you enable this option, you need to properly enter the
password set here when modifying the touch screen system time, allowing the user to modify the touch

screen system time

6. VNC Settings
HMI Parameter Setting | 2] 2 |
| eters | tvassword | cvr and dowmloading e locations and alarm system I Other | WHC
[7] Start VHC

VHC Port: [7530

VNC Password:

[ ok ] [ cancel ] | help

»  Start VNC: Enable VNC Settings
»  VNC Port: Set the VNC port number
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>  VNC Password: Set the VNC connection password
The special type touch screen supports remote through the VNC connection touch screen operation, detailed

reference to the “VNC connection”

e
L Tips:

Change of the screen saver time is not valid until "Screensaver screen" is chosen; just touch the screen of
screensaver to return to the former screen.

5.3 Download configuration engineering

Download configuration engineering

[
When complete the editing of configuration, you need to click the button B on the toolbar or employ the
-:"\
shortcut Ctrl + S, and then click \/ or execute the Compile command in the Download menu to compile.
During the compilation, the information output window will show the situation in real time. It can’t complete

the compilation if error exists. As shown in Figure 3-11:

X | erroriscreenl-MumDisplay-Maonitor AddressIntput error

=

Figure 3-11  Prompt of compiling error

You can modify it according to the error hint in the information output window; or you can also double-click
the error, then SKTOOL will automatically find the wrong object as well as select it. So engineers can
double-click on the object to view its property settings, find the reason of the error and make appropriate
alterations. After click the Save button to compile and execute the command again. If there is no error, the
system will pop up a dialog box indicating successful compilation after a while. At last, click OK to finish it, as

shown in Figure 3-12:

X | Compile Macro...
® |Not a macro instruction in engineering can be compiled

Compiles successfully

Figure 3-12  Information output window
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L Tips:
It’s necessary to compile before downloading while the step of conservation is required before compiling.
Otherwise it will fail to compile, as shown in Figure 3-11. After compilation, if you modify again, you need to

compile again.

i E !

Point cut

e —
.
i) i
| |
vy

Save the current project before compiling, whether to save?

[ ok ] l cancel

Figure 3-13  Compiling reminder

Finally, execute the command USB in Download menu to download through USB cable; engineers can also
directly select the command Compile + Download in Download menu. The implementation of the operation

brings up the following pop-up dialog box in Figure 3-12:

Download

[¥] Download local configuration Download remote configuration

@ USE
(") Ethernet
() Extract U disk file

Download configuration engineering

Connecting the HIM...

Connect the HIM.....OK

Checkint whether the HMI configuaration version is consistent...
The current HMI version is:7.0.3.7

Detected firmware version is:7.0.3.13

New firmware is detected,please choose update carefully...

0%

Figure 3-14  Download dialog
Click to download; the middle progress bar shows the downloading progress. After the downloading, a

pop-up window shows the completion of USB download. Click OK to complete the downloading task, as

shown in Figure 3-15:
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Download I. ? |

| &3

[¥] Dovnload local configuration Dovnload remote configuration

@ USE
() Ethernet
() Extract U disk file

The HMI model is:SK-070FE =
Checking version .....OK

To start the download project file...

Are download system parameters...

Are download configuration data...

Font file is being downloaded....

Is updating resource files...

Is to download a script instruction configuration file...
Is being downloaded driver files...

Waiting for the calibration data...

Update Successful! =

i |00
DownL oad

m

Figure 3-15 Downloading completed
The next step is the connection to the PLC to see whether the configuration project runs correctly in HMI.
Ways of connection between HMI and PLC or PC are shown in “Connection” in Hardware handbook.
]

L Tips:

Do not cut off the power of HMI, PC or USB cable and avoid other operations during the transmission process;

otherwise it will be affected.

Please install the USB drivers before downloading; otherwise the PC will not be connected to HMI. Thus you

will not be able to complete the downloading task.
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Download ? | B

[¥] Dovmload local configuration Download remote configuration

@ USE
1 Ethernet
() Extract U disk file

Download configuration engineering
Connecting the HIM...

Boiond

Figure 3-16  USB driver prompt

b ]

\

L Tips:
The pop-up dialog box, as shown in Figure 3-16, means that the PC does not recognize the HMI. Now it is
necessary to check whether the USB driver has been installed: Connect the PC and power-on HMI, and then
search “Samkoon HMI Tech Corp USB drive” in the Windows "My Computer" - "Properties" - "Hardware" -

"Device Manager" - "Universal Serial Bus controllers". (you can try to pull out the USB cable to check if the

PC can recognize HMI):

Configuration downloading through Ethernet
»  Set HMI network parameter settings

Open the dial switch 1 and 3 together; set the IP that can be set accordingly (here set it as
192.168.1.61), gateway, subnet and port. Fix the port to 12345.

»  Compile the configuration

If select downloading configuration through Ethernet it is necessary to input IP address and port
number in the input box. IP is that of the downloading target HMI. The IP here is 192.168.1.61 as

above, and the port is fixed to 12345. Then click to restart and download, as shown in Figure 3-18:
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Download @, &2

[¥] Download local configuration Doymload remote configuration
) UsE
@ Ethernet Ip: 192.168.1 .61 Port: 12345

() Extract U disk file

| o%

Eoiaad

Figure 3-18 Configuration downloading through Ethernet

5.4 Upload configuration engineering

Upload configuration engineering |

SKTOOL software supports uploading configuration program from the HMI to the hard disk. Connect HMI to
PC; select the option of "Upload project file" in the pop-up dialog box, and then the user interface of "Upload
Samdraw file" will appear.

7% HMIManager-1.0.0 X
[*¥ ~Communication settings -
< Download
& TSB
" WAN
Upload
...l P ¢ Serial pord
:'. ] i rUpload selection area -
, Simulation
= (" Upload history data

.-“i. {* Upload project ] browze

y Version info " Upload recipe

- Upgrade

" Upload history alarm

ﬁ_ Address list .
s Start Exit
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®  File Path: Click "Browse" to select the file in which you want to save the path.
® Project Name: Set the name of the project.
® Start uploading: Click Upload file to start.

After the success of the uploading, you can choose whether to open the project file.
]
L Tips:

It needs to extract the uploaded file before open it.
5.5 Upload historical data record

Upload historical data record

o

Run SKTOOL configuration software; click i .

A HMIManager-1.0.0 b4

¥ rCommunication settings -
' L, Download
+ USBE

s Simulation
-

=

~ S
j/ Version info

Upgrade

}, Address list

" WAN
i_ ]_ Upioad " Serial pord

—Upload zelection area

+ Upload history data ]D:,-"Hisdata

" Upload project
" Upload recipe

{" Upload history alarm

Start Exit

Selecting “Upload historical data record” means uploading it from HMI to the hard disk.

@® File Path: Storage location; select "Browse" to choose your storage path.

® File name: Name of the uploaded file; the uploaded file cannot be opened directly, so a data conversion
tool is necessary. Refer to “Export historical data and alarm to U disk” in the Help appendix for specific

operation.
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® Click "Upload File" to start uploading while the file is stored in the set location.

® SKTOOL newly add multiple set of historical data, so uploading historical data means, in addition to
uploading historical database file, and also saving each set of historical data in the database file as a .CSV
file. E.g., uploading a file called " temp ", then the according historical database file is named “temp”,

and that of CSV in group 0 is “temp_hisdata0.csv” while that of CSV in group 1 is “temp_hisdatal.csv”,
and so on.

s
SA Tips:

Operation of uploading historical data record is similar to that of uploading formula and project file; the

function of converting files from Samdraw3.3 to SKTOOL is disabled.

5.6 Pack/Unpack

Select “Pack/Unpack” in the Download menu to open the dialog box.

Zip/Unzip ? | =

Iip the file

Save psth: Browse...

Compresing

Unzip the file

Iip flie: | Browse...
Save pzsth: Browse...

| Lipping
0%

Cloze

® Zip the file: Zip the SK project file to generate a compressed file suffixed .sip. Used external images will
be also packaged into the compressed file. If users send the compressed file to another computer, the
images still exist after unzipping. However, if only send the configuration project file, you will lose

external images in other computers because the external images could not find the original image path.

® Save Path: Location to store the compressed file; after selecting the save path, Click "Compression", and

then close it when the progress bar reaches 100%.
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Unzip the file: Decompress a file-suffixed .skr into that of .skm which can be opened directly in SKTOOL.

Zip file: Choose files to be extracted.

Save Path: Location to store the decompressed file suffixed .skm; after selecting the save path, Click

"Zipping", and then close it when the progress bar reaches 100%.
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6. SKTOOL Configuration Guide

This chapter introduces in detail the configuration methods using SKTOOL software.

Contents:

® Screen Operations

® Graphics editing commands
® Graphics editing commands
® Basic controls

® Advanced controls

® New controls

® SKTOOL Control Instructions

6.1 Screen Operations

This chapter details screen operations of SKTOOL configuration.

Contents:

® Create a New Screen
® Modify Screen Property
® Delete Screen

® Delete Screen

® Automatic sorting
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6.1.1 Create a New Screen

Create a New Screen

“New Screen” command is used to create a new screen in the current project. Steps of creating new screens
are as follows:

the Screen menu in the project manager, and then select “Add Screen”, as shown in Figure 4 -1 below:

- UEE[HUU[I EELIJH%'-S

-1 onoes  Add Screen

- [ 0015
F Window Automatic sorting

Historica
I Alarmlo Paste(\V)

—

1. Select the “New Screen” command in the Screen menu or click the button command or right click

Figure 4-1 New Screen

2. In the pop-up "New Screen" dialog box, set the name and background color of the new screen, then click
OK. The default name of the new screen is a screen number; the default background color is blue, as shown in

Figure 4-2:

Mew Window

Screen Name: Screen.E
ID: 1 =
Background Fublic screen zetting

e P @ standard
@ t 2
S ) Public

BG Color: ) Use public
e color: I

Pattern: “:‘Solid x

) Picture:

[ ok J I cancel ]

Figure 4-2 Add screen dialog
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Standard: Standard picture

Public: Public screen can be used many times, the control property can only be modified in this picture

Use public: Use a public picture that has been created, but cannot modify the properties of the control in its
public screen

The Background color, Foreground color and Pattern of new screen can be set.

Picture: Picture can be set as background of new screen.

6.1.2 Modify Screen Property

Modify Screen Property

To modify the properties of the screen, including the name, background color, you can perform the following
operations:

Under the circumstances that no object or control is selected (you can click blank space in the current screen),

select the Bl command on the toolbar or left click to select the screen in the project manager, and then
right click on it or you can right click in the screen while on object is selected in order to bring up the context
menu in which you can find "Property" command.

F ™y

New Window ? | =&
Window Name: Window2
ID: 1 g
Fublic =screen zetting
Width: 240 = Height: 180 . @ Standard
@ Display in Middle © Display in Bl
(") Tze Public
7] Title 7] Close Buttor [¥] Top window
Title Hame:
EG Color:
[ ok J [ cancel ]

Figure 4-3 Screen Property settings
In the "New Screen" dialog box, set the name of the new screen, background color and public screen settings,

and then click OK. The default new screen name is the screen number.
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Default: set the background color, foreground color and style of the screen.
Photo: picture can be used as background.
Public picture settings
Standard screen: create a standard screen.
Set it to a public screen: Create a public screen in which the controls can be used on other screens,
but the properties of the controls can only be modified on that screen.
Use the Common Screen: Use the created Common Screen, but do not modify the properties of the

controls in the Common Screen.

6.1.3 Delete Screen

Delete Screen

This command is used to delete the screen in the current project; methods are as follows:

Select " Delete Screen" in the Screen menu; or left-click to choose the screen to be delete in the project
manager, then right click to select “Delete” key; or right click in the blank space in the screen while on object

is selected in order to bring up the context menu in which you can find "Delete" command.

SKTOOL

i Delete cannot be recovered Whether to continue?
A\

[ GO on ][ Cancel

Figure 4-4 Delete screen

Click OK to complete the operation of deleting.

t-?'

A Tips:

Once deleted, the screen cannot get back! Execute this command with caution.
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6.1.4 Copy Screen

Copy Screen [

This command is to copy the screen in current project; methods are as follows:

Left-click on the screen to be copy in the project manager, then right click to bring up the context menu and
select "Copy", after that right click to bring up the context menu and select "Paste"(Figure 4-5).
It would create a new screen copying from the assigned one.

e UPEIEUUIIJELUIIH:I

- [E Screen = 2] Screen
Pk _"DDD:Sreen‘l -2 000:Sreen’
R W 001:Screen2 = B 001:Screen2
- B8 Window Open(O) - B Window COpen(O)
5 Historical t_:Iata coll Insert(l) b Historical ;Iata coll Insert(l)
& Alarm Login - Alarm Login
- [& Recipe Delete(D) - [&] Recipe Delete(D)
% Data Transfer “ % Data Transfer
= & Script Property(F) = )' Script Properiyif) _
e # Script Editor N f 5 /4 Script Editor c

- & Global Script - & Global Script opy(C)

- 1 Init Secript Paste(V) - 1 |nit Script Paste(V)

- 1 Trigger Script i = T TriggerScript —————

Figure 4-5 Copy and Paste Screen

“ g Operation setings
=[] Screen

~ 2] 000:Sreent

& B 001:Screen2
- [ 002:Screen2-copy

6.1.5 Automatic sorting

“Automatic sorting” command is used to create a new screen in the current project. Steps of creating new
screens are as follows:

The automatic sort command is used to sort the picture number in the current picture. Methods are as
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follows:

Select the project manager the picture option by clicking the left mouse button, then right-click menu select
"automatic sorting and automatic sorting will prompt the settings screen, select the automatic sorting
function, click OK, can carry out sorting operation on the current screen (from small to large order).

The specific process is shown in the following picture:

W vEnduig lduie ]
4 |[E ) |
= .Screz_a‘i Add Screen
00|
Ll 00 Automatic sorting
-] DDOFSEFEEHI T
1 003%:Screend
| 004:5creend
M Windeow

Click the left mouse button options, right-click select "automatic sorting."

r T™

Setting ¥ =

[V] futomatic zorting

0k | | Cancel |

L -

Check the automatic sorting, click OK

Screen

o] 00eScreenl
| 001:Screen2
il 002:Screen3
1 003:5creend
(K] 004:5creens

6.2 Graphics editing commands

This chapter details SKTOOL graphical editing commands.

Contents:

® Group and Ungroup

® layer
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® Rotaty

® Align

6.2.1 Group and Ungroup

Group and Ungroup

The combination command is a group command, which is to combine 2 or more graphics objects and controls
in the current screen into a graphic object, a whole, and 2. The contents of the combination can be graphics
drawn by engineering designers, or drawn by themselves, or can be system library graphics, or other controls,
such as alarm controls, trends, and so on. After the combination control, keep the property of the original
control object, which can be modified. The cancellation combination is to decompose the graph which is
combined with the combination command into several original combination elements, and cancel the

combination command is the reverse operation of the combination command.

Methods of Grouping:

First it needs to select multiple graphic objects, and then select the Group command ﬁ in the Edit menu,
or that command button in the toolbar menu, or right click to bring up the context menu and select "Group"
item, before and after comparison picture is as Figure 4-6:

Figure 4-6before and after group command

Methods of ungrouping:

Select a combined graphic object from grouping, and then select the Ungroup command EI in the Edit
menu, or in the toolbar menu, or in the context menu; before and after comparison picture is as Figure 4-7:
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Figure 4-7before and after ungroup command

‘-T
L Tips:

Select multiple objects through Ctrl key.

6.2.2 Layer

Lavyer

Layer Command is by group. It is used to adjust the display level of intersecting graphic objects. Each object
SKTOOL has a graphic level; the top of the graphic objects are always displayed on top of the lower graphic
objects, so you can use this command to adjust the hierarchy level. The default level of new graphic object is
higher than that of original. SKTOOL Layer consists a total of four commands: Bring To Top, Bring Forward,
Send to Bottom and Send Backward. To execute this command, you need first select one or more graphical
objects on the current screen, and then select the corresponding command in the Edit menu or toolbar

menu.
» Bring To Top

Execute this command to move the selected graphic object to the uppermost layer of all graphic objects, so

that the selected graphic object will overwrite the intersecting part.

First choose an object in several graphs, and then choose Bring To Top command in Edit menu, or command

button iLIin the toolbar buttons, or call the right click menu and choose Bring To Top command in the Layer

option. See Figure 4-8 for a comparison before and after combination.
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Figure 4-8 Contrast before and after Bring To Top

> Send To Bottom

Execute this command to send the selected graphic object to the lowermost layer of all graphic objects, so

that the intersecting part of the selected object will be invisible.

First choose an object in several graphs, and then choose Send To Bottom command in Edit menu, or

command button % in the toolbar buttons, or call the right click menu and choose Send To Bottom

command in the Layer option. See Figure 4-9 for a comparison before and after combination.

Figure 4-9 Contrast before and after Send To Bottom

»  Bring Forward

Execute this command to bring the selected graphic object one level forward to the intersecting graphic
objects. You first need to select one object in multiple graphic objects, and then select "Bring forward" in the
Edit menu or the toolbar button, or right click to bring up the context menu containing “Bring forward” in the

series commands of Layer.

First choose an object in several graphs, and then choose Bring Forward command in Edit menu, or command

buttonE in the toolbar buttons, or call the right click menu and choose Bring Forward command in the
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Layer option. See Figure 4-10 for a comparison before and after combination.

it o aa
H

Figure 4-10  Contrast before and after Bring Forward
»  Send Backward

Execute this command to send the selected graphic object one level backward to the intersecting graphic
objects. You first need to select one object in multiple graphic objects, and then select " Send backward" in
the Edit menu or the toolbar button, or right click to bring up the context menu containing “Send backward”

in the series commands of Layer.

First choose an object in several graphs, and then choose Send Backward command in Edit menu, or

command button EIin the toolbar buttons, or call the right click menu and choose Send Backward command

in the Layer option. See Figure 4-9 for a comparison before and after combination.

e

Figure 4-11  Contrast before and after Send Forward

6.2.3 Rotaty

Rotate |

This command is by group. SKTOOL configuration editor software allows engineers to rotate one or more
graphical objects at any angle. Graphic objects that can be rotated to contain straight lines, circles, rectangles,

graphics system library, controls, a combination of graphics, and polygons.

»  Flip Horizontal
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“Flip horizontal” allows engineers to rotate the graphic object (may be a plurality of graphic objects) at 180°by

the axis of vertical center in the horizontal plane after selecting. First select one or more graphical objects,

then click “Flip Horizontal” in the Edit menu "Mirror" or click the Flip Horizontal button in the Tool bar "

When a single graphic object is selected, as shown in Figure 4-12:

Figure 4-12  Contrast before and after Flip Horizontal of single graph object
> Flip Vertical

“Flip Vertical” allow engineers to rotate the graphic object (may be a plurality of graphic objects) at 180°by

the axis of horizontal center in the vertical plane after selecting. First select one or more graphical objects,

then click “Flip Vertical” in the Edit menu "Mirror" or click the Flip Vertical button in the Tool bar | Whena

single graphic object is selected, as shown in Figure 4-14:

Figure 4-14  Contrast before and after Flip Vertical of single graph object
» Rotating

Currently, only the following 12 controls are supported to support this function:

Time Display, Date Display. Week Display, Static Picture, GIF Display. Picture, Numentric Display.

Numerical Input, ASCII Display, ASCII Entry, MultiState Lamp, MultiState Switch

After rotation allows engineering design personnel selection controls, to object center as the dot,
memory 360 °.Select an object, click the "rotate" command in the edit menu, or click the rotate button

in the tools button
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Rotation process

6.2.4 Align

Alignment and Size

This command is by group, so is the Size. SKTOOL configuration software allows engineers to operate
alignment and size operation on multiple graphical objects, but only when multiple graphic objects are
selected. Users can hold down the key Ctrl to select the graphic objects to be aligned, or hold down the left
mouse button and drag to delineate them. Alignment operations include a large number of editing
commands: Left, Right, Vertical Center, Horizontal Center, Top, Bottom, Horizontal Equal Interval and Vertical
Equal Interval, Make same width, Make same height, Make same height and width, etc.

> Em Top

The command of Top Alignment allows engineering designers to top justify multiple graphic objects (no less
than two graphical objects) through clicking “Top” of the Alignment in the Edit menu or through the context
menu. These graphic objects will take the highest edge of graphic objects as a reference, and then make them
at the same level. Before and after comparison diagram of Top Alignment is shown in Figure 4-16:

Figure 4-16 Before and after comparison diagram of Top Alignment

1[I

» —— Bottom

The command of Bottom Alignment allows engineering designers to bottom justify multiple graphic objects
(no less than two graphical objects) through clicking “Bottom” of the Alignment in the Edit menu or through
the context menu. These graphic objects will take the lowest edge of graphic objects as a reference, and then
make them at the same level.

Before and after comparison diagram of Bottom Alignment is shown in Figure 4-17:
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Figure 4-17 Before and after comparison diagram of Bottom Alignment

> Vertical Center

The command of Vertical center allows engineering designers to make centers of graphical objects in the
same vertical line (no less than two graphical objects) through clicking “Vertical center” of the Alignment in

the Edit menu or through the context menu. This vertical line is the vertical centerline of the leftmost and
rightmost edges.

Before and after comparison diagram of Vertical Center Alignment is shown in Figure 4-18:

Figure 4-18 Before and after comparison diagram of Vertical Center Alignment

—
> — Left

The command of Left Alignment allows engineering designers to left justify multiple graphic objects (no less
than two graphical objects) through clicking “left” of the Alignment in the Edit menu or through the context
menu. These graphic objects will take the leftmost edge of graphic objects as a reference, and then make the
left sides of each graphic object along the same vertical line.

Before and after comparison diagram of Left Alignment is shown in Figure 4-19:

Figure 4-19 Before and after comparison diagram of Left Alignment

—

> =lRight
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The command of Right Alignment allows engineering designers to right justify multiple graphic objects (no
less than two graphical objects) through clicking “Right” of the Alignment in the Edit menu or through the
context menu. These graphic objects will take the rightmost edge of graphic objects as a reference, and then
make the right sides of each graphic object along the same vertical line.

Before and after comparison diagram of Right Alignment is shown in Figure 4-20:

Figure 4-20 Before and after comparison diagram of Right Alignment

. =

% Make same width

This command allows engineering designers to make multiple graphic objects (no less than two graphical
objects) have the same width through clicking “Make same width” of the Size in the Edit menu or through the
context menu. These graphical objects will be reduced or enlarged by the upper left point while the height
remains unchanged, so that the width of each graphic object is in accordance with what has been selected
before (surrounded by black points while others by green points).

Before and after comparison diagram of Make same width is shown in Figure 4-21:

39
2389

Figure 4-21 Before and after comparison diagram of Make same width

> [E: Make same height

This command allows engineering designers to make multiple graphic objects (no less than two graphical
objects) have the same height through clicking “Make same height” of the Size in the Edit menu or through
the context menu. These graphical objects will be reduced or enlarged by the upper left point while the width
remains unchanged, so that the height of each graphic object is in accordance with what has been selected
before (surrounded by black points while others by green points).

Before and after comparison diagram of Make same height is shown in Figure 4-22:

116



[ | [ | [ |
o 5| |
= 99 |l
O 9999 [ ] [ ] [ ] | | [ ] [ ]
O |
- | | 99 |I
i | 9999 |
| | u
o + B B
H +

Figure 4-22 Before and after comparison diagram of Make same height

> Make same height and width

This command allows engineering designers to make multiple graphic objects (no less than two graphical
objects) have the same height and width through clicking “Make same height and width” of the Size in the
Edit menu or through the context menu. These graphical objects will be reduced or enlarged by the upper left
point, so that the height and width of each graphic object is in accordance with what has been selected
before (surrounded by black points while others by green points).

Before and after comparison diagram of Make same height and width is shown in Figure 4-23:
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Figure 4-23 Before and after comparison diagram of Make same height and width

> I-H Horizontal Equal Interval

This command allows engineering designers to make multiple graphic objects (no less than two graphical
objects) have the equal interval horizontally through clicking “Horizontal Equal Interval” of the Alignment in
the Edit menu or through the context menu.

> E Vertical Equal Interval

This command allows engineering designers to make multiple graphic objects (no less than two graphical
objects) have the equal interval vertically through clicking “Vertical Equal Interval” of the Alignment in the
Edit menu or through the context menu.

s
SA Tips:
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Before executing commands of Make same width, same height, same width and height, please make sure
whether the selected objects have been rotated. The height and width of rotated object also rotate with
itself.

6.3 Draw Basic graphics

This chapter details operations of drawing basic graphics with SKTOOL.

Contents:
® Line
® Polyline

® Curve/Arc

® Freeline

® Rectangle

® Rounded Rectangle

® Circle/Ellipse

® Polygon
® Sector
® Text

® Table

® Scale

® Open Library

® Saveto Library

® Regular polygon
118


修改画面属性.htm
basic%20graph/creat%20gallery.htm
basic%20graph/zhengduobianxing.htm

6.3.1 Line

Line f

Select the “Line” command in Draw menu or left-click the line button Ei/j in the toolbar; move the mouse
in the screen editing window, and it will become a cross; click on the mouse in the view (i.e. screen), then a

line is added.

After the above steps, the transparency of the line, the line type, width, color, the arrow and shape of end will

be set by default while engineers can modify these properties in order to meet the needs of projects. Double

click over a straight line, or click on the Property buttonJ in the toolbar after selecting it. Line Property

dialog box will pop up, as shown in Figure 4-24:

-~

Line I?_ P

General Visibility |

Alpha

|3

285 =

Line

Line Tj.rpe:|—1 T]

Fitie Width: I Svie Cu:ulu:ur:!

Shape
Endﬂrruw:| ] v]
EndCap :I chamfering - ]
[ ol J I cancel I [ help

Figure 4-24  Line Property dialog box
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SKTOOL configuration software provides up to 6 straight line types, 30 kinds of line width, and 6 straight-line
end arrows, with the ability to adjust the properties using the pull-down and trimming buttons. To change the
length, direction, and position of the line, select the line first, then move the mouse to the end of the line;
after that hold the left button of the mouse, and drag the mouse to the right position to release the left

button.

6.3.2 Polyline

Select the Polyline command in the Draw menu or click the Polyline command button 5 in the toolbar to
move the mouse to the Edit window. The mouse will change to a cross. That’s when you can draw a polyline

in the Edit window.

Move the mouse to a position where you want to draw the polyline. Click the left mouse button once, then a

small green dot appears in the screen editing window, which is an endpoint of the polyline.

Move the mouse to other positions in the screen, the system will automatically draw a straight line; move the
mouse to change the direction; left click once and the place where you click will appear a small green box.
Here the line from the first endpoint to the first small green rectangle will not move with the mouse. The
mouse can be moved to the next point to change the direction of the polyline, just click the left mouse button.
When you need to complete the drawing of the polyline. Lastly right click to complete drawing the polyline, as

shown in Figure 4-25:

Figure 4-25 Polyline Operation

After finishing the above steps, the transparency, line type, line width, line color, end arrow and end point
shape of the polyline will be set by default. The engineer can modify these attributes to meet the needs of

the project. Move the cursor to the polyline; double-click the left button, or first select the line, and then click

I

the toolbar property buttonJ , a dialog box same as that of Line Property will pop up.
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You can adjust the properties of the polyline using the pull-down and fine-tune buttons. The SKTOOL
configuration software provides up to 6 straight line types, 30 kinds of line width, and 6 types of end arrow
for polylines. To change the length, direction and position, select the line first, and then move the mouse to
the polyline; hold down the left button of the mouse, after, drag the mouse to the appropriate location to

release the left button.

6.3.3 Curve / Arc

Select the Curve / Arc command in the Draw menu or click the Curve / Arc command button H in the
toolbar menu; move the mouse to the Edit window, then the mouse cursor will change to a cross, by now you

can draw a curve / arc in the Edit Window.

Move the mouse to a position where you want to curve. Left click and a small green dot appears in the

window. This position is the start position of the curve / arc.

Move the mouse to other position in the screen, then the system will automatically draw a straight line; after

click the left mouse button and release.

At this time, the mouse cursor is still cross-shaped. Move the mouse to other position in the screen, which is
the end of the curve / arc. Hold down the left button does and move the mouse in the screen to draw the arc;

release the mouse and right click to end the operation. As shown in Figure 4-26:

~

Figure4-26 Curve Operation

As shown above, the starting point of the graph is a green dot, and the end point is a diamond dot, here the
initial curve / arc has been drawn. Move the mouse to the point and the cursor becomes the shape of *#;
hold down the left mouse button, move the mouse to the appropriate location, and then release the mouse
to draw the required curve. You can also move the start or end point to the appropriate position. As shown in

Figure 4-27:
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Figure4-27 Curve Operation

After completing the above steps, the transparency, line type, line width, line color, end point and endpoint
shape of the curve / arc will be set by the system default. The engineer can modify these attributes to meet

the requirement of engineering. Move the mouse to the curve / arc; double-click the left button, or select the

curve / arc first, and then click the toolbar property buttonJ , a dialog box same as that of Line Property

will pop up.

You can adjust the curve / arc properties through the pull-down and trimming buttons. The SKTOOL
configuration software provides up to 15 line types, 10 kinds of line widths, and 6 straight-line end arrows for

curves / arcs.

6.3.4 Free Line

Select the Free Line command in the Draw menu or click the Free Line command button lbi?‘“ in the toolbar.
Move the mouse to the Edit window and the cursor will change to a cross shape so now you can draw a free

line in the Edit window.

Move the mouse to a position where you want to free line; click the left mouse button, and a small green dot

will appear in the editing window, which is the starting position of the free line.

Move the mouse to other positions in the screen, and then the system will automatically draw a free line
following the trajectory of the mouse movement; click the left mouse button or right button to complete

drawing the free line. As shown in Figure 4-28:

Figure4-28 Free Line Operation

122



After the above steps, the transparency, line type, line width, line color, end arrow and end point shape of the
free curve will be set by the system default. The engineer can modify these attributes to meet the needs of

the project: Move the cursor to the free curve, double-click the left button; or select the free curve first, and

Il

then click the toolbar property buttonJ , a dialog box same as that of Line Property will pop up.

In this case, you can adjust the properties of the free curve through the pull-down and fine-tune buttons. The
SKTOOL configuration software provides up to 6 straight line types, 30 kinds of line width and 6 types of

straight-line end arrows for curves / arcs.
6.3.5 Rectangle

Select the Rectangle command in the Draw menu or click the Rectangle command buttong:g in the toolbar
button. Move the mouse to the Edit window and then the cursor will change to a cross; click on the screen to

add a rectangle.

To change the size of the rectangle, select the rectangle first, and then move the mouse to the eight square

i Ry

green dots which appear in the rectangle. When the mouse cursor becomes “or or , click and
hold down the left mouse button to drag the rectangle; release the left mouse button when it reaches the

appropriate location. By now a required rectangular box is drawn.

*. Change the width of the rectangle

: : Change the height of the rectangle

P : Change the width and height of the rectangle

After the above steps, the transparency, line type, line width, line color and fill pattern of the rectangle will be
set by the system default. The engineer can modify these properties to meet the needs of the project. Move

the mouse to the rectangle, double click the left button; or select the rectangle first, and then click the

i

Property buttonJ in the toolbar. The properties of the rectangle will pop up, as shown in Figure 4-29:
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Figure 4-29  Rectangle properties dialog

You can adjust the properties of the rectangle through the pull-down and fine-tune buttons. SKTOOL
configuration software provides up to 15 types of borderline, 10 kinds of borderline width and 21 kinds of fill

patterns. As shown in Figure 4-30:

Figure 4-30  An example of a rectangle drawn

6.3.6 Rounded Rectangle

Choose the E::'} icon from Basic Graphs in the control bar, move the cursor to editing area, and the cursor
will become a cross.

Click the starting position where the graph will be placed, drag the cursor when pressing the mouse key. At
this moment the system will automatically draw an area along the track of the cursor. Then, click left or right
mouse key to complete drawing of rectangle.

To change the size of the rounded rectangle, select the rectangle first, and then move the mouse to the eight
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square green dots which appear in the rectangle. When the mouse cursor becomes “or : or P , click

and hold down the left mouse button to drag the rounded rectangle; release the left mouse button when it
reaches the appropriate location. By now a required rounded rectangular box is drawn.

23 Change the width of the rounded rectangle
I : Change the height of the rounded rectangle
P : Change the width and height of the rounded rectangle

After the above steps, the transparency, line type, line width, line color and fill pattern of the rounded
rectangle will be set by the system default. The engineer can modify these properties to meet the needs of
the project. Move the mouse on it, double click the left button; or select the rounded rectangle first, and then

click the Property buttonJ in the toolbar. The properties of the rectangle will pop up, as shown in Figure
4-31

Round Rect ? P

Corner Radius: 10

Corner Radius=: 10

Border

Line Twvpe:—1 -
Line Width:[D - Line Colox: [

FPad

Pattern:H:‘SDlid v] Alpha: 265 5

Bz Color: ‘ Fiz Colur:!

ok ]| cancel |[ help |

Figure 4-31  Rectangle properties dialog

Radius of X curve: Radian of the four corners in X direction.
Radius of Y curve: Radian of the four corners in Y direction.

6.3.7 Circle/Ellipse

Select the Circle/Ellipse command in the Draw menu or left-click the Circle/Ellipse command button @ in
the toolbar. Move the mouse to the screen editing window, and the mouse cursor will become a cross; click

the left mouse button on the screen to add a circle to the screen.
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To change the size of an ellipse / circle, select the Circle/Ellipse first, then move the mouse to the 8 square

green dots that appear in the ellipse / circle. When the mouse cursor becomes “or : or P , click and

hold down the left mouse button to an appropriate location; release the left button to complete drawing.

23 :Change the width of the ellipse / circle

: :Change the height of the ellipse / circle

P :Change the width and height of the ellipse / circle

After the above steps, the transparency, line type, line width, line color, and fill pattern of the ellipse / circle
will be set by default. The engineer can modify these attributes to meet the needs of the project. Move the

cursor to the ellipse / circle, double click the left button; or select the Circle/Ellipse first, and then click the

Property button _|Jiin the toolbar, here a dialog box will pop up.

The SKTOOL configuration software provides up to 15 types of border line, 10 kinds of border line width and

21 of fill patterns for ellipse / circle. As shown in Figure 4-32:

Figure4-32 Circle/Ellipse

6.3.8 Polygon

Select the Polygon command in the Draw menu or click the Polygon command button I{z\ﬂ;in the toolbar.
Move the mouse to the editting window. The mouse will change to a cross, by now you can draw a polygon in
the screen.

Move the mouse to a position where you want to draw a polygon, left click (or hold down the left button),
then a small green dot will appear in the screen editing window, which is the start point of the polygon.

Move the mouse to another position on the screen. At this time, the system will draw a straight line

automatically. Move the mouse to other appropriate positions; each time you left click, a new side of polygon
is drawed; right click to complete drawing. As shown in Figure 4-33:
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Figure 4-33 Polygon Operation

To re-shape a polygon, click it first and it will appear several green dots (depending on the number of sides of
the polygon), indicating that the polygon has been selected; and then move the mouse cursor over one of
them, then it will become the shape *¥*; left click and drag it to the position you prefer, so that you can
change the length and location of two lines connected by this turning point. Release the left button to

complete.

After the above steps, the transparency, line type, line width, line color and fill pattern of the polygon will be
set by the system default. The engineer can modify these attributes to meet the needs of the project. Move
the mouse over the polygon, double click the left mouse button; or select the polygon first, and then click the

Property buttonJ in the toolbar, and a dialog box same as that of the rectangle will pop up.

You can adjust the properties of polygon through the pull-down and fine-tuning buttons. SKTOOL
configuration software provides up to 15 types of border line, 10 kinds of border line width and 21 kinds of fill
patterns for the polygon.As shown in Figure 4-34:

Figure 4-34 Polygon

6.3.9 Sector

Select the Sector command in the Draw menu or left-click the Sector command button Din the toolbar;
move the mouse to the screen editing window, and then it will become a cross, which means you can draw a
pie chart in the screen now. As shown in Figure 4-35:
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Figure 4-35 Sector Operation

Move the mouse to any point of the green dots in the middle of the rectangle, then the mouse will change to

4

the shape

6.3.10 Text

Select the Text command in the Draw menu or left-click the Text command button*

¥ change the arc of the sector by moving th emouse.

bring up the Static Text dialog box, as shown in Figure 4-36:

-

Static Text

Genaral_l Visibility |

Language: [[] 411 language use the first language te

Tze text 1] v Text 1ib|
Text
TEXT
Fort Size 10 ~ Font: |Arlal -

[ Bold [] Ttalic [[] UnderLine Pozition

Font Color:!rd Interval: 0 =
Flicker: No =

7] sutoline

Fill

Pattern:“:‘ Tranzparent VI

Back Color: Tront Color:!

Alpha: 255 5

[ ok ]l cancel H help

Figure 4-36 Static Text dialog box

> Input the text to be displayed in TEXT in the dialog box above.
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The size of the font to be displayed can be changed in the drop-down menu of Font Size. SKTOOL
configuration software provides the font size of 7-56 pound.

Engineering designers can change the types of fonts to be displayed in the drop-down menu of Font.
SKTOOL configuration software provides almost all font styles.

Language: For different languages, you can enter different text contents in the text box, different font
and font size are also available..

In the dialog box, click the left button before the Bold and Italic box to change the fond.

The configuration software provides kerning and line spacing that vary from 0-15 through the fine-tuning
button next to the kerning and line spacing

SKTOOL configuration software also provides up to 16 kinds of underline form, and can change the

display position of text contents in the text box; you can also change the fill pattern and transparency.

Text renderings

»  When the font property is modified, click OK to close the dialog box. Move the mouse to where you
want to place the text in the editing window; left click the left mouse button, and the system will draw a
rectangle automatically.

» To modify or re-input the text contents, double-click the text unit with the left mouse button, then
re-enter the contents through the keyboard. You can use the Enter to change line feed when using the
keyboard.

» Tochange the size of the text background box, select the text unit, and then move the mouse to its edge;
when the mouse becomes ¥ or ! or P , click and hold down the left mouse button to pull the text
box to the appropriate location; after that release the left mouse button to complete the operation.
HChange the width of the text unit background

. Change the height of the text unit background
& Change the width and height of the text unit
6.3.11 Table

Select the Table command in the Draw menu or the left click the command button!-

in the toolbar, then it

will appear a pop-up table dialog box, as shown in Figure 4-39:
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Table ® e
General_
Bz Culur:é
[] Border
Cell
.zontal Number:d % :rtical Number:4 =
Grid
[¥] ¥ertical Line Tvpe:|—1 -
[¥] Horizontal Line Color:
[ ol J I cancel I [ help

Figure 4-39  table dialog box

In the above dialog box of the above diagram, SKTOOL configuration software provides choices of the
Background Color, Border, Grid and Grid lines. You can decide whether to display vertical or horizontal grid

lines in the Grid option, and the type and color of lines are changeable.
-/
L Tips:
The table is just a graphic object, which means you cannot add text, data or other embedded objects to the

table. The table can only be displayed as a chassis image. To display text, data, and other objects on a table,

you can use Text and numeric display objects to overlay the table and set it to the top layer.

6.3.12 Scale

Select the Table command in the Draw menu or the left click mouse the command button in the toolbar,

then it will appear a pop-up scale dialog box, as shown in Figure 4-41:
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Scale ? | B
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—100 Color
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Fort Size: 10 » Point count: 0 -

[ ok JI cancel H help

Figure 4-41  Scale Dialog Box

In the above dialog box, SKTOOL configuration software provides choices of Color, Axis and Text. The color
item allows to selecting the line color and text color. You can select whether to display the axes in the Axis
item and decide the number of the major scale and sub scale by means of the trimming button or inputting
directly. Decide whether to display text in the text item and change the maximum and minimum values of the

scale, as well as the size of the text and the decimal digits of the scale value.

When you have modified the scale property and click OK to close the dialog box, move the mouse to the

position where you want to display the scale. Click the left mouse button, and then the system will

automatically draw a scale unit. As shown in Figure 4-42:
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Figure 4-42  Scale effect diagram

After the above steps, a scale like first from left of the figure above. If you want to change it to the form of the
second left scale in the figure above, first choose the scale, move the mouse to one of the height sides, press

+—F

down the left key and drag the mouse when the mouse becomes ™ *, and have the mouse pass through the

other height side. To change the scale to the right forms in the figure above, perform Free Rotation for it.

6.3.13 Open Library

Select the Open Library command in the Draw menu or click the Open Library command buttonE in the
toolbar to bring up the Library List dialog box, as shown in Figure 4-43:

T ~
Open Library & = |

Library
4 Systems Library
4 Button Libr--
Buttonl
Button2
Button3
Button4
Button3
Buttont
Button7
Buttond
Buttond
Buttonl10
Buttonll
Buttonl12
Button13
4 Indicator Li*
Indicatorl
Indicator2
Indicator3
Indicatord

Indicator5 -

ok
modification

cancel

help

Figure 4-43  Library List

The system library of SKTOOL configuration editing software provides a wealth of graphic objects for
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engineering designers. SKTOOL version is even added a large number of buttons, indicators and other graphic

objects. Engineering designers can find a proper graphic object so as to save configuration design time.

Engineers only need to click on the category of the desired graphic object in the system library on the left.
Click the + sign to open the sub-category, and then select the desired graphic. Click to select the image, and

then click on the screen to add graphic object when the cursor become a cross.

Modify: After selecting the graphic you want to modify, click the "Modify" button at the bottom left of the

dialog box, as shown in Figure 4-44:

Graphic modification t'@ i
A N e e e S0 e et i B N 0 0 1 1 O |.?‘..J

Display Attri
BG Colar
Pattern [Jselid

FG Color

Line Width 0
Line Calor
Line Style 0

Alpha

=]

Layer

Text Content

Save

=i

Figure 4-44 Library Modify Dialog Box

In the interface shown as Figure 4-44, select the graphic, and then execute the "Split" function on the tool bar
to split the control. Then you can choose one part to modify: settings of foreground color, background color,
pattern and others can be found on the right of the dialog box. After modification, execute the Group

command to the entire split graphics, and then click the "Save".
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Save to user-defined library B

Custom

4 |Custom Library
Library 1 I
Library 2
Library 3
Library 4
Library 5
Library 6
Library 7 |
Library 8
Library 9
Library 10
Library 11
Library 12
Library 13
Library 14
Library 15

dete a seleation chjec
Save
Clese

= = = = ——— =

Figure 4-45  dialog box is displayed

In the "Custom" list on the left of the dialog box, select the location where you want to save the modified

graphics (e.g. "Library 2") and click "Save". If you want to view the newly saved graphics, click the Open Lib

command button L%fin the pop-up dialog box, then select the "Custom Library".

6.3.14 Extern Picture

In SKTOOL, pictures can be inserted into a number of controls; take the Static Picture as an example:
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Static Picture 2 2|

Element type Static Picture

Static Picture

View
ID:
Picture: @ Library
1 File
Picture Path: ﬁ_'
Frompt

Function:Provide a
zingle image
dizplay function

Picture:
Library: Built-in gallery in the system, as shown below:

Open Library

Library il
4 Systems Library
4 Button Libr'
Buttonl |
Button2
Button3
Button4
Button5
Buttont
Button7
Button8
Button9
Buttonl0
Button11
Button12
Button13
4 Indicator Li-

Indicatorl
Indicator2
Indicator3
Indicatord
Indicators -

modification

cancel

thi

NN B ANEN
File: Consist of External File and System File. External pictures can be those in computer and system pictures
are available for downloading on the official website, which will be saved in the folder of Extern_Pic under the

installation directory.
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When "System" is selected, the following dialog box will pop up:

' 5 ” . i — = > L@
Gallery image list lesiln )
Gallery image o ) o
4 System picture
Button 5
Circlebutton 1
L
Lamp
: 81 = &1 81 x 81 g1 x 81 81 x &1 8l x 81 | 4
Pipe
Switch
Xbutton i
4 Share picture
Mator
81 x 81 81 x 81 g1 x 81 81 x &1 g1 x 81
|
g1 = 81 &1 = &1 81 x &1 81 = 81 &1 = &1
I
|
—
Cancel :
161 = 81 333 = 187 161 = 81 161 = 51 161 = 81
g ,

These images are stored in the Extern_Pic folder under the installation directory, as shown below:

- [= [ [ ]
@C}.| 1 v B, » WE==E2= (D) + Program Files » SKTOOLZ.0 » ~[4|[ m=skrooize ]
b=l g = I BEIEF v HE v BRI R FEF Bt FriEuits =~ 0 @
o s 2 =R Bs8 =3 Fh fmid ot
B TE 1. Drivers 2019/7/10 15:16 i ]
me=E 1. drivers32 2019/7/10 15:16 i ‘=
T 1) Drivers3352 2018/7/10 15:16 S
Bl BEAERE =
= : || Extern_Pic 2019/7/10 15:16 i
. )\ iconengines 2018/7/10 15:16 ik
& = ¥ imageformats 2019/7/10 15:16 i
H wn || Marco 2019/7/10 15:16 =
== 1\ Project 2019/7/10 15:16 i
[ = )i RemateTool 2019/7/10 15:16 i
J =5 1. resource 2019/7/10 15:28 iz
) sqldrivers 2019/7/10 15:16 i
& = |\ usB 2019/7/10 15:16 i
R czh (AAL-PC) - | addresscfg 2018/8/27 10:48 CFG i 27 KB )|
| Extern_Pic S2E5: 2019/7/10 1516
JI& =

The Extern_Pic folder contains two folders: the share_picture folder and system_picture folder, corresponding
respectively to the shared picture and system picture in the Gallery image list, of which those in the
system_picture folder are system pictures that cannot be added or modified. While those in the share_picture
folder can, as shown in the following figure:
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You can add other folders by yourself in the share_picture folder or change the name of an existing folder (for
example, Motor), meanwhile the name of share_picture folder cannot be changed. In addition, it is possible
to add or delete pictures of the Motor folder.

t-T
A Tips:

The compressed file of share_picture.rar is available for downloading on the official website; unzip it into PC

after downloading; follow the above method to add it into the share_picture folder, and then it is also
available in the Gallery image list.

6.3.15 Regular polygon

Select the straight line command in the drawing menu or the left mouse button to click the regular polygon

e

{ ]

| A,
command button in the toolbox button to set the number of corners, transparency, line type, line
width, line color of the regular polygon. To meet the needs of the project. After setting, click the button to
determine the button, the screen appears cross mark, move to the appropriate position of the screen, click

the left, you can draw a regular polygon. You can click the right polygon control through the left mouse button,

[y

right-click the "property" or click the toolbar button , set the property, modify the regular polygon.
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Regular polygon ?

Baze property '

Polygonal : 3 E
Alpha: 255 .
Frame Fill

Tvpe: 1] v| Pattern: ||:|S|:|lid v|

| ok | [ cancel | [ Help

J

Figure 4-24  Line Property dialog box

= |

The size of the control can be freely stretched by controlling the green dots around it.

6.4 SKTOOL Advanced controls

This chapter introduces the advanced controls.

Contents:

® GIF Display

® Trend Chart

® XY Trend Chart
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修改画面属性.htm

® Dynamic Circle

® Dynamic Rectangle

® Alarm Display

® Alarm Bar

® Historical Alarm Display
® Graphics Move

® Meter

® Historical Data Display
® Message Display

® Flowing block

® Timers

® Multi-function keys

® Pieshow

6.4.1 GIF Display

GIF display can be used to display images of GIF format, supporting 32 frames at most. Operation is as

follows:

Click the GIF icon@ on the toolbar to display the dialog box shown in Figure 4-48.
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Gif Display PR
Element type General Advanced | Visibilitwy
GIF Dizplay
ID: |GIF0000
Picture: h

Tiew

prompt

Function:For displaying GIF format

images

[ ok ][ cancel |[ Help

Figure 4-48  GIF Display dialog box

After setting the properties, click "OK", then the mouse cursor will become a cross in the editing area; left

click to draw a rectangle and the control is added to the view area (i.e. the screen)

Select the "Advanced" page to display its properties.

Gif Display 7| =
Element type General | Advanced | Visibility
GIF Display
1D: |5IFO000 [¥] By Bit Control
View Control bit:
bvailable State: @ 1 [

prompt

Emction:For displaying GIF format

images

[ ok |[ cancel |[ Help
\

Figure 4-49  GIF Display "Advanced" page

Controlled By bit: When "Controlled by Bit" is selected, if the "Active Status" selected is 1, the GIF picture will
be animated if and only if the value of "Control bit" is 1, otherwise it is a static display; when the selected
"Active Status" is 0, the GIF picture will be animated if and only if the value of "Control Bit" is O, otherwise it

will be displayed statically.
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s
SA Tips:

The "Visibility" page can refer to the use of "Bit Button" control.

6.4.2 Trend Chart

Trend Chart Summary:

Dynamic, variable and continuous value displayed continuously.

Draw reference curves of multiple data. Take the time as the horizontal axis, the value as the vertical
coordinate axis, in order to accurately and intuitively judge the change tendency of a certain value during a
period of time.

Up to 8 polylines can be displayed (line graph).

Add properties of the trend graph:

1. Select the Trend Chart icon@ in the toolbar, and then the properties dialog box appears, as shown in
Figure 4-50

Trend Chart ? g

General | Pen | XY Awis | Visibility |

ID:LC0000

BG Color: Alpha: 255

Date type:llﬁ—E:Lt Unsigned Int .
Check:
[ use
Read Trigger bit: Curve number: 4

[ ftomatic Reset y of Data Points Per Data: g0 z

Read Add : =
= S | Variable data points

Sanpling time: 1 Tlels
Direction:@ Left to Right

) Right to Left
[#] Show Data Point Marker [[] If use comtrol address

[¥] Show Connected Line

Bk color:
lear Trigger bit:
[7] dutomatic Reset

[ ok ]l cancel H help

Figure 4-50  Trend Chart Common Dialog Box
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® Background color: Change the background color of the trend chart. The effect cannot be visible until you
click OK.

® Data type: 7 kinds of data types are available for users.

® Read trigger bit: Only when the "Read trigger bit address" value is 1, the curve will move around.

® Curve number: Number of lines, up to 8.

® Automatic reset of Read trigger bit: Whe the read address detected is 1, then the address value is
assigned to 0.

® Number of data points per group: Number of data shown on the X-axis.
Sampling time: The sampling frequency.
Read Address: The value of the Read Address represents the value of each line on the Y-axis direction.
According to different data group numbers and data types, Read address can be read continuously
(16-bit data) or read at intervals (32-bit data).

® Variable data points: According to the address value of the dynamic set of "Number of data points per
group." When this option is selected, the address value default is the initial value of the Number of Data
Points per Group.

Detection

® Enabled: Indicate whether the detection line (reference line) is enabled.

® Color: The color of the detection line (reference line).

® Detection address: Write the value of the current detection line (reference line) to the detection address.

® Whether to use the control address: Set the dynamic minimum and maximum value of the Y-axis

according to the value of control address value. This address occupies five consecutive address shifts;
change the minimum and maximum value of the Y-axis scale referencing the X-axis and also whether to

restore the initial state.

Address
Control Register Address Control object
Offset

0 | 16 bits less than the minimum value

1 | 16 bits more than the minimum value

2 | 16 bits less than the maximum value

3 | 16 bits more than the maximum value

Whether to restore the initial state of the maximum and minimum values. The address

value of 1 indicates a dynamic change, otherwise the initial value is restored

t_}..

SA Tips:

The control address can only use the internal address, and the minimum and maximum value account for two
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consecutive word address respectively.

E.g.:

When the 16-bit data type is selected and the number of data groups is 8, it is assumed that the user-input
address is LW3, and 8 groups of address values are continuously read out,
LW3: The value of linel

LW4: The value of line 2

LWS5: The value of line 3

LW6: The value of line 4

LW7: The value of line 5

LW8: The value of line 6

LW9: The value of line 7

LW10: The value of line 8

Therefore, when the user selects 16-bit data and sets the number of N groups of data, the user can read out

the address values of the N groups in succession according to the address rules of different PLC models.

When the 32-bit data type is selected and the number of data groups is 5, it is assumed that the user-input
address is LW3. Then, 5 sets of address values are read out consecutively.

LW3: The value of line 1

LW5: The value of line 2

LW7: The value of pen 3

LW9: The value of line 4

LW11: The value of line 5

Therefore, when select 32-bit data and set the N-group data group number, user can read out the N group
address value by adding 2 to the address value (at interval) according to the address rules of different PLC

models.

Direction:
Left to right: The line moves from the left.
Right to left: The line moves from the right.

Background color: The color of the line

e 6 o o Y

Clear Trigger Bit: Clear the current status of all lines when the address value changes from 0 to 1 (rising
edge). The line remains the same when the address value changes from 1 to 0 (falling edge) or has no
change,.

The "Line" page of the Trend Chart is shown in Figure 4-51: This page allows user to set the maximum value,
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minimum value, style and color of each pen.

Trend Chart

=5
b

| Gemeral | Pem | XY Amis | Visibility |

Pen #1 Pen #2 Pen #3 Pen #4

Fill ty‘pe:‘Nu fill = Fill type:/No fill = Fill type:|No fill = Fill type:/No £ill =
Line: L:me:II] L1r\e:|— 1 = Line:| —1 e
Color:! Color:! Color:! Color:!

[ ok |[ cancel |[ help

Figure 4-51  Trend Chart Pen Dialog Box

The data type in the General page determines that of the maximum and minimum values here.

For example, if the maximum or minimum value is a floating-point number, user must first select 32-bit

floating-point number in the Data Type in the General page. Otherwise, an error will occur when user clicks

IIOKII.

3. The "XY Axis" page of the trend chart is shown in Figure 4-52:
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Trend Chart

Vizibaility |

I Axis
[¥] Show Ticks

[7] Show T-fxis Grid

Jxis/Tick Color: _

Main Scale Fum: 4
Sub Scale Fum: 2
[¥] Show Marks

Font Size: 10 -

T Axis
[¥] Show Ticks

[#] Show ¥-ixis Grid

bx1s/Tick Color: !‘

Main Scale Mum: 4

Sub Scale Num: 2 B

[¥] Show Marks

Font Size: 10 -
Mir:0
Maze: 1000
Total:iq E

*oint count:0

[ ok

H cancel ||

help

Figure 4-52

X-axis

Trend Chart XY Axis Dialog Box

Display scale: whether to display the X-axis scale.

Show Y-axis grid: Whether to display Y-axis grid.

Axis / Scale Color: Change the color of the X-axis / scale.

Grid Color: Change the X-axis grid color.

Main sub-scale: X-axis main scale.

Sub-scale: X-axis times the number of times.

Display Scale Indicates whether the X-axis scale is displayed.

A\

Y-axis

Display Scale: Whether to display the Y-axis scale.

Show X-axis grid: Whether to display the X-axis grid.

Axis / Scale Color: This option changes the color of the Y-axis / scale.

Grid Color: This option changes the Y-axis grid color.

Major scale division: Numbers of Y-axis major scale.

Sub-scale division: Numbers of Y-axis sub-scale.

Show Marks: Whether to display the Y-axis scale mark.

Font Size: Change the font size of the Y-axis scale.

Minimum: The minimum value of the Y-axis scale.

Max: The maximum value of the Y-axis scale.

Total: Display the maximum digital number of the data.
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® Decimal Place: The maximum digital number that can be displayed after the decimal point.

s
SA Tips:

The "Visibility" page can refer to that of "Bit Button" control.

6.4.3 XY Trend Chart

XY Trend Chart Overview:
Dynamic, variable and continuous value displayed continuously.

You can draw multiple data reference curve, and take two consecutive register address value as the horizontal

axis and vertical axis coordinates respectively, in order to observe the change rules accurately and intuitively.

Up to 8 polylines can be displayed (line graph).

Operations of adding XY Trends and modifying XY Trend Properties are similar to those of Trend Chart. Users

can refer to the "Trend Chart" page operation. Open the iconLJ

Open the XY Trend Property dialog box; refer to the "Trend Chart" property settings. It should be noted that
each line in the Trend Chart represents the value of consecutive addresses starting from the write address,
and each in the XY Trend Chart represents the value of two consecutive addresses starting at the write

address.

XY Trend Chart Application:

Color: The color of the detection line (reference line).

Detection address: Write the value of the current detection line (reference line) to the detection address.

For example, if 16-bit data type is selected and the number of data groups is 4, assuming that the user-input
address is LW3, 8 sets of address values are continuously read,

LW3: Linel Value of the X-axis

LW4: Line 1 Value of the Y-axis

LWS5: Line 2 Value of the X-axis

146



LWG: Line 2 Value of the Y-axis
L